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Safety Guidelines 
This manual contains notices you have to observe in order to ensure your personal safety, as well as to 
prevent damage to property. The notices referring to your personal safety are highlighted in the manual 
by a safety alert symbol, notices referring to property damage only have no safety alert symbol. The 
notices shown below are graded according to the degree of danger. 

 

!  
Danger 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

!  
Warning 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

!  
Caution 
with a safety alert symbol indicates that minor personal injury can result if proper precautions are not 
taken. 

 
 Caution 

without a safety alert symbol indicates that property damage can result if proper precautions are not 
taken. 

 
 Notice 

indicates that an unintended result or situation can occur if the corresponding notice is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of 
danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a 
warning relating to property damage. 

Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning 
and operation of a device/system may only be performed by qualified personnel. Within the context of 
the safety notices in this documentation qualified persons are defined as persons who are authorized to 
commission, ground and label devices, systems and circuits in accordance with established safety 
practices and standards. 

Prescribed Usage 
Note the following: 

 

!  
Warning 
This device and its components may only be used for the applications described in the catalog or the 
technical description, and only in connection with devices or components from other manufacturers 
which have been approved or recommended by Siemens. 
Correct, reliable operation of the product requires proper transport, storage, positioning and assembly 
as well as careful operation and maintenance. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG.  
The remaining trademarks in this publication may be trademarks whose use by third parties for their 
own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and 
software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. 
However, the information in this publication is reviewed regularly and any necessary corrections are 
included in subsequent editions. 

이 기기는 업무용(A급) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며 가정 외의 지역에서 사용하는 것을 목적으로 합니다.
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Preface 

Purpose of the Documentation  
This documentation provides detailed information about the WinAC Slot software 
and hardware that includes the CPU 412-2 PCI and the CPU 416-2 PCI. You install 
the WinAC Slot software and documentation from the installation CD.  

The CPU 412-2 PCI and the CPU 416-2 PCI are the programmable logic 
controllers (PLCs) for the Windows Automation Center (WinAC). A CPU 41x-2 PCI 
is a card that fits in a PC in a PCI slot for 3/4-length cards. The CPU 41x-2 PCI is 
part of the WinAC family of PC-based controllers. You can also use SIMATIC 
products with PC-based controllers, such as WinCC flexible. 

The PC-based controllers use a PROFIBUS DP network to communicate with 
distributed I/O, such as an ET 200M. In addition, you can use PG/OP 
communication (PROFIBUS, MPI, or Industrial Ethernet) to connect the PC-based 
controllers to STEP 7 or to another computer. 

Basic Knowledge Requirements 
General knowledge about automation systems is needed to understand this 
documentation. 

In addition, the following knowledge is required: 

• Comprehensive knowledge of the S7-400 

• Comprehensive knowledge of STEP 7 

Scope of Documentation 
This documentation applies to the following modules: 
  

Product Version (or higher) CPU Order number 

Firmware Hardware 

CPU 412-2 PCI 6ES7 612-2QH10-0AB4 4.0 1 

CPU 416-2 PCI 6ES7 616-2QL10-0AB4 4.0 1 

This documentation describes all applicable modules at the time of publication. We 
reserve the right to provide product information bulletins containing current 
information for any new modules or modules with a new release number. 

This documentation describes how the CPU 412-2 PCI and CPU 416-2 PCI differ 
from the CPUs of the S7-400 family. For more information, refer to the manuals for 
S7-400. 
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What's New? 
The following changes have been made compared to WinAC Slot 41x, Version 3.4: 

• Enhanced performance 

• The PS Extension Board is integrated on the CPU. As a result, the CPU 41x-2 
PCI only requires one slot. 

• The fan interface of the PC fan is improved. The PC fan is not regulated and 
no longer runs continuously. 

Location of Documentation 
The installation of WinAC Slot V4.0 includes the following documentation: 

• WinAC Slot as online help and as a PDF file  

• WinAC Time Synchronization V4.0 as online help and as a PDF file (if 
installed) 

• SIMATIC S7-400 instruction list containing the programming instructions for the 
CPU 41x-2 PCI.  

The online help is started from the controller panel. The PDF files are accessible 
from the Start > Simatic > Documentation menu command.  

Approvals 
The CPU 41x-2 PCI has the following approvals: 

 
 

Underwriters Laboratories (UL) in accordance to  

• Standard UL 60950, File-No. E115352 and Canadian Standard C22.2 
No. 60950 (I.T.E) and  

• Standard UL 508, File-No. E85972 and Canadian Standard C22.2 No. 14 05 
(IND.CONT.EQ) 

CE Mark 
The CPU 41x-2 PCI meets the requirements and protection goals of the following 
EC directives. 

• EC Directive 89/336/EWG “EMC Directive” 

C-Tick Mark 
The CPU 41x-2 PCI meets the requirements of AS/NZS CISPR 22 (Australia and 
New Zealand). 
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Standards 
The CPU 41x-2 PCI satisfies the requirements and criteria of IEC 61131-2. 

Relationship to Other Manuals 
This manual describes how the CPU 412-2 PCI and CPU 416-2 PCI differ from the 
CPUs of the S7-400 family. The following documents are also needed: 

• STEP 7 - Programming with STEP 7. This manual provides basic information 
on designing and programming a WinAC Slot STEP 7 user program.  

• STEP 7 - System and Standard Functions for S7-300 and S7-400. This manual 
provides you with descriptions of the system functions, organization blocks, 
and loadable standard functions. 

• STEP 7 - Working with STEP 7. This manual explains the usage and the 
functions of the STEP 7 automation software. This manual provides you with 
an overview of the procedures used to configure WinAC Slot and to develop 
STEP 7 user programs.  

• SIMATIC NET - Commissioning PC Stations This manual supports you when 
commissioning your SIMATIC NET PC modules in a PC station. All SIMATIC 
NET software tools and their operation are described (available once SIMATIC 
NET is installed). 

• SIMATIC NET - Industrial Communication with PG/PC, Parts 1 and 2. This 
manual helps you with setting up industrial communications over PROFIBUS 
and Industrial Ethernet communications networks (available if you install 
SIMATIC NET) 

• SIMATIC S7-400 Programmable Controllers CPU Specifications Reference 
Manual. This manual describes the operation of the S7-400 with PROFIBUS 
DP, the memory concept, and the estart methods. 

• SIMATIC S7-400 Programmable Controllers Hardware and Installation 
Installation Manual. This manual describes the networking and commissioning 
(resetting the CPU with the mode selector; warm restart and hot restart with 
mode selector). 

• SIMATIC S7-400 Programmable Controllers Module Specifications Reference 
Manual. This manual provides a description of the RS 485 repeater. 

• SIMATIC S7-400 Instruction List. This manual provides you with a complete list 
of instructions that are applicable to the WinAC Slot PLCs as well as 
information on addressing and performance data. The instruction list is 
included as a PDF file in this documentation package. The CPU 412-2 PCI 
corresponds to the specifications for the CPU 412-2 (6ES7 412-2XG04-0AB0), 
and the CPU 416-2 PCI to those for CPU 416-2 (6ES7 416-2XK04-0AB0). 

The SIMATIC manuals can be accessed on the PC with the installed SIMATIC 
software using the Start > Simatic > Documentation menu command. 
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Guide 
The manual contains the following tools to help you locate information quickly: 

• At the beginning of the manual, you will find a complete table of contents as 
well as a list of figures and a list of tables. 

• Following the appendices, you will find a glossary containing the important 
terms used in the manual along with their definitions. 

• At the end of the manual, you will find a detailed index enabling you to access 
needed information quickly. 

Recycling and Disposal 
The CPU 41x-2 PCI can be recycled due to their non-toxic material content. For 
environmentally safe recycling or disposal of your old device, contact a waste 
disposal company certified to handle electronic scrap. 

Further Support 
If you have questions regarding the products described in this manual, contact your 
Siemens representative. 

To locate your representative, point your browser to: 

http://www.siemens.com/automation/partner 

You can find a guide to the technical documentation offered for the individual 
SIMATIC Products and Systems at: 

http://www.siemens.de/simatic-tech-doku-portal 

The online catalog and online ordering system is available at: 

http://mall.automation.siemens.com/ 

Training Center  
We offer training courses to help you get started using SIMATIC S7. For more 
information, contact your regional training center or the main training center at P.O. 
Box 4844, D-90327 Nuremberg.  

Telephone:  +49 (911) 895-3200.  

Internet: http://www.sitrain.com 

http://www.siemens.com/automation/partner
http://www.siemens.de/simatic-tech-doku-portal
http://mall.automation.siemens.com/
http://www.sitrain.com
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Technical Support 
Technical support for all A&D products is available 

• By filling out a Support Request at 

http://www.siemens.de/automation/support-request 

• Telephone: + 49 180 5050 222 

• Fax: + 49 180 5050 223 

For additional information regarding technical support, point your browser to 
http://www.siemens.de/automation/service 

Service & Support on the Internet 
In addition to documentation, you can access our complete knowledge base on the 
Internet at 

http://www.siemens.com/automation/service&support 

There, you will find: 

• Newsletters with the latest information on your products. 

• Relevant documentation via the search function in Service & Support. 

• A forum where users and specialists from around the world exchange 
information. 

• Your local Siemens Automation & Drives representative. 

• Information on local service, repairs, and spare parts and much more is 
available under "Services“. 

http://www.siemens.de/automation/support-request
http://www.siemens.de/automation/service
http://www.siemens.com/automation/service&support
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1 Product Overview 

1.1 Introduction to PC-Based Automation 
The WinAC (Windows Automation Center) PC-based controllers are operated 
within a standard PC and provide the same functionality as SIMATIC S7 CPUs 
(hardware controllers). The controllers include  

• WinLC Basis  

• WinLC RTX  

• WinAC Slot  

WinAC Slot is a PCI slot card that is used in a PC.  

The CPU 41x-2 PCI supports multiple networks and connects to distributed I/O 
and/or Industrial Ethernet stations over the PROFIBUS DP or MPI interface or 
Industrial Ethernet cards that you have installed in your computer.  

As part of the SIMATIC family of products, die CPU 41x-2 PCI can also 
communicate with STEP 7 or other SIMATIC products, such as WinCC, WinCC 
flexible, ProTool Pro or other SIMATIC S7 controllers, including any of the PC-
based controllers, over PROFIBUS, MPI or Industrial Ethernet networks.  

 
You can use the same programming languages, program structure and 
programming user interface (STEP 7) as for hardware PLCs to develop your 
process control solution. Programs designed for S7 controllers can run on 
PC-based controllers and vice versa. The PC-based controllers also contain a 
controller panel that runs on the PC. With these functions, you can use the 
CPU 41x-2 PCI in a typical factory automation configuration.  
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1.2 Components of a PLC with a CPU 41x-2 PCI 

Overview 
The WinAC Slot 41x package includes the following components: 

• WinAC controller - CPU 412-2 PCI or CPU 416-2 PCI slot PLC, two CPUs from 
the S7-400 product line for PC-based applications.  

• Controller panel, which represents the operating controls and displays of the 
CPU 41x-2 PCI on a screen. 

• WinAC Time Synchronization for synchronization of the CPU 41x-2 PCI using 
a SIMATIC NET CP (Industrial Ethernet or PROFIBUS) or the PC-internal 
clock. 

• SIMATIC NET OPC Server on the provided SIMATIC NET CD. 

CPU 41x-2 PCI (WinAC Controller) 
You use the CPU 41x-2 PCI to control your process. It provides an effective 
hardware solution for your automation projects. The I/O are connected via 
PROFIBUS DP.  

Controller Panel 
The CPU is operated with a controller panel that is displayed on the PC screen. 
The panel is based on the front panel of an S7-CPU and provides the 
corresponding functionality. 

You can also use the controller panel to read out the content of the diagnostic 
buffer. 

A password can be used to restrict access to the controller from the controller 
panel so that only authorized personnel can change the settings. 
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Time Synchronization (WinAC Time Synchronization) 
WinAC Time Synchronization enables the real-time clock of the WinAC controller 
(e.g., WinLC RTX or CPU 41x-2 PCI) to be synchronized to a central time-of-day 
source. Synchronization to the following is possible: 

• Central real-time transmitter via a PC communications processor (e.g., 
CP 5613 or CP 1613) 

• PC-internal clock 

WinAC Time Synchronization is implemented as a Windows service. The service is 
started automatically when the computer is booted. Time synchronization starts if 
the service was not stopped before the computer was turned off. The update 
period is fixed at 10 s. 

Separate documentation is available for WinAC Time Synchronization. Refer to the 
online help for WinAC Time Synchronization. 

Programming 
The WinAC controller is configured and programmed the same as SIMATIC S7 
with STEP 7. The LAD, FBD, STL, S7-SCL programming languages and all 
graphical programming languages such as S7-GRAPH, S7-HiGRAPH, and CFC 
can be used.  

Programming can be done locally on the same PC as well as remotely via 
networks or the integrated PROFIBUS interfaces. 

Access to Process Data 
Process data are accessed via the SIMATIC NET OPC Server. You can install this 
server from the provided SIMATIC NET CD. 

Interface to Display 
The SIMATIC WinCC/WinCC flexible HMI system and the ProTool Pro visualization 
software can be linked via an optimized interface. 

A SIMATIC NET OPC server with data access interface is available to link any 
visualization system based on Windows 2000/XP. You can install this server from 
the provided SIMATIC NET CD. 
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Communication 
If you want to perform communication via Industrial Ethernet or a PROFIBUS 
subnet, a communication module (CP) must be installed in your PC.  

The options for communicating with other nodes are: 

• Connection to PROFIBUS DP via the integrated interface 

• Connection to MPI or PROFIBUS DP via the second integrated interface 

• Connection to PC via the PCI interface 

• Connection to another network such as Industrial Ethernet/PROFIBUS via a 
communications processor (CP) 

Technology on the PC 
WinAC Slot is equipped with a shared memory interface on the PCI bus. This 
enables very fast data exchange between a PC application and WinAC Slot. 
Development of this PC application is supported through WinAC ODK 4.1. 

Multi Slot 
You can operate up to four CPUs 41x-2 PCI in one PC or up to three 
CPUs 41x-2 PCI together with WinAC Basis V4.1 and higher or WinAC RTX V4.1 
and higher. 

Each of the CPUs works autonomously, i.e., operating states are not coordinated 
and the CPUs do not have any common I/O or data areas. Thus, multi-slot mode is 
not the same as "multicomputing" in the S7-400. 

Components 
The following components are available for setting up and commissioning WinAC 
Slot: 

 
Component Function Illustration 

CPU 
• CPU 412-2 PCI 
• CPU 416-2 PCI 

 

• Executes the user program. 
• Communicates with other 

CPUs or with a 
programming device via the 
MPI interface. 

• Communicates with DP 
masters and DP slaves via 
the DP interface. 

• Communicates with 
applications in the PC via 
the PCI interface. 
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Component Function Illustration 
PC, e.g.,  
• Box PC 627, 840 
• Panel PC 577, 677, 

877 
• Rack PC IL 43, 840 
• Workstation PCU 50 
• Standard PC 

... accepts the CPU 41x-2 PCI. 
The PC can configure, 
parameterize, and program the 
CPU 41x-2 PCI, provided you 
have installed a STEP 7 
package. 

 

Memory card ... stores the user program and 
parameters.  

Programming device (PG) 
or PC 

... for configuring, 
parameterizing, programming, 
and testing the CPU 41x-2 PCI 
via MPI. 
You do not have to have a 
separate programming device to 
configure the CPU 41x-2. You 
can also use the licensed STEP 
7 package on the PC. 

 

PROFIBUS bus cable 
with bus connector 

... connects nodes of an MPI or 
PROFIBUS subnet to one 
another. 

 
PG cable ... connects the CPU 41x-2 PCI 

to another PG/PC via the MPI 
interface. 

 
SIMATIC NET 
components 

CP 1613 , CP 5613 (also A2), 
CP 5611, or Standard Ethernet 
card for connection of the CPU 
41x-2 PCI to Industrial Ethernet.  

Location of order numbers and release number 
The order number and release number are noted on a label on each 
CPU 41x-2 PCI. The appropriate release number is marked with an "X". 
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1.3 Introduction to the Controller Panel 
The controller panel corresponds to the faceplate of the SIMATIC S7 CPUs. 
The controller panel is a display 
window on your PC that contains 
the following elements for working 
with the controller:  
• Two operating mode selector 

switch positions for changing 
the operating mode of the 
controller  
(similar to the mode selector 
switch on an S7 CPU front 
panel.) 

• Status indicators for the 
controller  

• MRES switch for resetting the 
CPU  

• Menus for controller 
operations 

 

Opening or closing the controller panel does not influence the state of the 
controller. The status of the operator switches and the LEDs are stored in the 
controller. 
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1.4 Key Communication Data 
Communication with the PG or OS or configured AS-AS communication via 
Industrial Ethernet, MPI, or DP is possible. The following interfaces can be used: 
CP 1612, CP 1613, CP 5613, CP 5611, integrated and standard interfaces of the 
PC. 

Constraints: the FMS and FDL protocols and AG-Send/AG-Receive are not 
supported! 

 
Communication via WinAC Slot 41x CP/ 

interface 
Required 
SIMATIC 
NET 
software 
license 

Protocol Number of 
Connections 
via WinAC 
Slot 41x1, 2 

Communication 
with PG, OS, etc. 

Configured AS-
AS 
Communication 

SOFTNET-
S7 

Industrial 
Ethernet 

64 Yes Yes 

SOFTNET-
S7 Lean 

Industrial 
Ethernet 

8 Yes Yes 

CP 16123 

SOFTNET-
PG 

Industrial 
Ethernet 

64 Yes No 

CP 1613 S7-1613 Industrial 
Ethernet 

64 Yes Yes 

PROFIBUS 50 Yes Yes CP 5613 S7-5613 

MPI 50 Yes Yes 

PROFIBUS 8 Yes Yes CP 5611 SOFTNET-
S7 MPI 8 Yes Yes 

 PROFIBUS CPU 412-2 
PCI: 16 
CPU 416-2 
PCI: 32 

Yes Yes Integrated 
interfaces 

 MPI CPU 412-2 
PCI: 16 
CPU 416-2 
PCI: 44 

Yes Yes 

PC-internal  S7 64 Yes Yes 

 
1 The number of S7 connections applies when Credit = 1 and PDU size = 480 
bytes. For other settings, refer to the Product Information for SIMATIC NET. 
2 For CPU 412-2 PCI, a maximum of 16 connections are permitted; for CPU 416-2 
PCI, a maximum of 64 connections are permitted. 
3 Applies also to standard Ethernet interface of a PC. 
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1.5 System Requirements 
To use the CPU 41x-2 PCI, your personal computer (PC) must meet the following 
criteria:  
 

Category Requirement 

Operating 
System 

One of the following operating systems: 
• Microsoft Windows 2000 Professional Service Pack 3 or 

higher   
• Microsoft Windows XP Professional Service Pack 1 or 

higher 

Processor 
and memory 

Pentiumsystem: 
• 300 MHz 
• At least 128 Mbytes of RAM 

Hard drive A hard disk with 120 Mbytes of free space for the complete 
installation  
The setup program uses at least 60 Mbyte of available memory 
on Drive C: for the setup program (setup files are deleted once 
the installation is complete). 

Operator 
interface 

A color monitor, keyboard, and mouse or other pointing device 
(optional) that are supported by Windows 

Slot At least one free PCI slot of 3/4 length for the CPU 41x-2 PCI. 
PCI: 3.3 V or 5 V; at 3.3 V max. 66 MHz, at 5 V max. 33 MHz. 

Siemens 
software 

Programming and configuration software: STEP 7 V5.3 SP2 or 
higher with the installed hardware update for WinAC Slot V4.0 
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1.6 Windows User Privileges 
You are not required to have Windows Administrator (ADMIN) privileges in order to 
perform operations, such as changing the operating mode of the controller, 
archiving or restoring control programs, or setting the security options. 

With Power User, User, or even with Guest privileges, you can perform any 
operation from the controller panel.  

As shown in the following table, some operations are restricted to certain Windows 
User privilege classes. 
 

Operation Administrator Power User User Guest 
Installing 
WinAC Slot 
software 

Allowed Not allowed Not allowed Not allowed 

Configuring or 
modifying the 
PC Station 

Allowed Allowed Not allowed Not allowed 

Performing 
WinAC 
operations  

Allowed Allowed Allowed Allowed 

1.7 Using Help 
The online help system provides information about the controller panel and the 
controller. This topic provides information about using online help:  

• Accessing Help from the Controller Panel 

• Using the Table of Contents 

• Using the Index 

• Using Full-Text Search 

• Printing Help Topics 

• Changing the Language of a Help Topic 
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Access to the Online Help in Windows XP SP2 
In Windows XP SP2, the online help display may be blocked based on your 
security settings.  

If the following message appears: "To help protect your security, this file has been 
restricted from showing active content that could access your computer," proceed 
as follows:  

1. Click the message to display your options. 

2. Select "Allow blocked content…". 

3. Click "Yes" to confirm the security warning. 

Result: You can now access the online help. Access ends when you close the 
online help. 

We recommend that you follow this procedure to access the online help. For 
security reasons, do not change your firewall settings or your Internet Explorer 
settings! 

1.7.1 Accessing Help from the Controller Panel 
To access online help from the controller panel, use one of the following methods: 

Help on Panel 
The Help > Help on Panel command opens the initial page of the online help for 
the controller panel. This help system describes the controller panel when it is not 
connected to a controller. The table of contents is in the left navigation pane. 

Help on Controller 
The Help > Help on Controller command displays the initial page of the online 
help for the controller that is connected to the controller panel. It describes 
controller and controller panel operations. The table of contents is in the left 
navigation pane. 

Introduction  
The Help > Introduction command displays a topic that provides an introduction 
to PC-based control and the controller itself. 
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Getting Started 
The Help > Getting Started command displays a topic that helps you get started 
when you begin using the controller panel to work with the controller for the first 
time.  

• Click the Help button in a dialog or message box to view information about that 
specific dialog or message box. 

• Press the F1 key to view context-sensitive help on the currently selected item 
(for example, a window, dialog, or menu).  

Using the Table of Contents 
The table of contents is in the left pane of the web browser and provides navigation 
within the online help system:  

• Click a book to open it and display the books and topics that it contains.  

• Click the book again to close it.  

• Click any topic within the table of contents to display that topic.  

- The topic you are currently viewing is highlighted in the table of contents. 

- The table of contents can be either hidden or displayed: 

• Click the "x" in the left navigation pane to close the table of contents. 

• Select the Contents button on the browser or the "Show" link in a topic to 
display it. (The "Show" link appears only when you have displayed a context-
sensitive topic from the application.) 

1.7.2 Using the Index 
The index provides access to information about a specific subject. Use one of the 
following methods to access the index: 

• Select the Index button on the browser. (If the Index button is not visible, click 
the "Show" link at the top of the topic. The "Show" link appears only when you 
have displayed a context-sensitive topic from the application.) 

• Click the Index button in any help topic. 
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1.7.3 Using Full-Text Search 
To use the full-text search capabilities of the online help, use the search field that is 
displayed above the topic, or select the Search button on the browser. (If the 
Search field and Search button are not visible, click the "Show" link at the top of the 
topic. The "Show" link appears only when you have displayed a context-sensitive 
topic from the application.) 

The full-text search supports the Boolean operators AND, OR, and NOT and 
parentheses in your search expression. Wildcards ("*") are not supported. 

1.7.4 Printing Help Topics 
To print a single topic that is displayed in your browser, right-click in the topic pane 
and select Print from the context menu. Select the print options of your choice. 

1.7.5 Changing the Language of a Help Topic 
The browser contains language buttons for each of the supported languages. To 
see the current help topic in another language, click the language button of your 
choice. The current topic is displayed in the language you selected, but the 
contents, index, and search features of the online help system remain in the 
original language. This may be helpful if a topic is unclear and you want to read it 
in another language.  

If you select a language that you have not installed, the online help system cannot 
display the topic in that language and displays a "Page not found" error. Changing 
the language of an online help topic does not change the display language of the 
controller panel.  
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2 Installing the CPU 41x-2 PCI and the 
Software 

2.1 Interfaces 

CPU Interfaces 
The figure below shows the interfaces of the CPU 41x-2 PCI: 

 
• PROFIBUS DP interface 

The CPU 41x-2 PCI has an integrated PROFIBUS DP interface. You can use 
this interface to connect distributed I/O. 

The CPU 41x-2 PCI can be operated as a DP master or DP slave on 
PROFIBUS DP. 

• MPI/PROFIBUS DP interface 

You can use the MPI/PROFIBUS DP interface either as an MPI interface or as 
a PROFIBUS DP interface (default: MPI interface). 

The multipoint interface (MPI) of the CPU 41x-2 PCI is used to connect to an 
MPI subnet or for direct connection of an OP or a PC or programming device 
with STEP 7. 

The MPI interface can also be parameterized as a DP interface. For this 
purpose, you can use SIMATIC Manager in STEP 7 to reassign the MPI 
interface. Here, you can configure a DP line with a maximum of 32 DP slaves. 
The boundary conditions of the PROFIBUS DP interface are applicable (see 
above). 
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Note 
Pin 7 of the MPI-/ PROFIBUS DP interface does not have 24 V available, 
e.g., for supplying operator panels. 

• Slot for memory card 

You can insert a memory card in this slot on the CPU 41x-2 PCI. A detailed 
description is available in Memory Cards. 

• Connection of external 24 VDC voltage supply  

• Connection of external backup battery 

• Connection of PC fan (X3, X4, or X5 - depending on the connector type) 

• Connection of fan supply (X2) to motherboard or power unit 

• Operating mode selector 

The operating mode selector allows you to switch the CPU 41x-2 PCI to RUN 
mode irrespective of the operating mode of the PC. 

• LEDs on the slot bracket 

The slot bracket of the CPU 41x-2 PCI contains LEDs. These are in addition to 
the LED displays on the controller panel. For the meaning of the LEDs, refer to 
Changing the Operating Mode of the Controller and Status Displays. 

- SF (INTF, EXTF) 

- R (RUN) 

- S (STOP) 
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2.2 Fitting the CPU 41x-2 PCI 

Procedure 
The following table shows you the basic procedure for fitting the CPU 41x-2 PCI. 

 
Step Procedure 

1 Switch off the PC  

2 Open the PC 

3 Set up the battery monitoring 

4 Insert the memory card 

5 Insert the CPU 41x-2 PCI into the PC 

6 Connect the CPU 41x-2 PCI to the power supply 

7 Connecting a Fan  

8 Close the PC 

Requirement 
The CPU 41x-2 PCI requires a PCI slot with standard clearance. 

Switching Off and Opening the PC 
Caution 
The electronic components on the printed circuit boards are extremely 
sensitive to electrostatic discharges. Observe the rules for handling 
electrostatic sensitive devices (see Guideline for Handling Electrostatic 
Sensitive Devices ESD). 

1. Switch off the PC and remove the power plug for the 230 V supply on the rear 
panel. 

2. Open the PC as described in the owners manual for your PC or programming 
device. 

3. Use switch block S2 on the CPU 41x-2 PCI to specify whether or not battery 
monitoring is to be suppressed. You should suppress battery monitoring if you 
are not using a battery. Otherwise, the BATF LED would be constantly 
illuminated on the controller panel even though no backup battery is being 
used. 

Note 
Switch block 2 is located on the main board of the CPU 41x-2 PCI between 
the two circuit boards. 
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Suppressing the Battery Monitoring: Switch Setting 
 

If ... Then ... Switch Setting 

You are not using battery 
monitoring 

Set DIP Switch 1 to the 
OPEN position 

 

You are using battery 
monitoring 

Set DIP Switch 1 to the NOT 
OPEN position 

 

 

4. Insert the memory card. 
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5. Insert the CPU 41x-2 PCI onto an available PCI slot on the mother board. 

6. Screw the CPU 41x-2 PCI to the back panel of the PC. 

If you want to use more than one CPU 41x-2 PCI in multi-slot mode, repeat the 
steps indicated above. 

7. Connect the PC fan to the CPU, if applicable. For more information, refer to 
Connecting the Fan. 

8. Finally, connect the PC as described in the relevant manual and reconnect the 
network cable. 
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2.3 Connecting the CPU 41x-2 PCI to the Power Supply 

2.3.1 Important Information 
This section provides decision-making guidance for connecting the CPU 41x-2 PCI 
to the power supply. Depending on the power supply type and the settings in the 
Restart Method and Autoload dialogs (refer to Status and Error Indications), the 
restart behavior of the CPU 41x-2 PCI will vary. 

• Operation without an external independent 24 VDC power supply and without a 
backup battery 

When the PC is switched off, the data are lost. 

You have the option of storing the STEP 7 user program in a memory card file 
on the PC and loading this file automatically to the CPU 41x-2 PCI after Power 
On. 

The automatic warm restart/hot restart feature is not available. 

• Operation without an external independent 24 VDC power supply but with a 
backup battery 

The CPU 41x-2 PCI is independent of the PC as long as the power supply of 
the PC functions, i.e., a warm restart of the PC does not affect operation of the 
CPU 41x-2 PCI.  

If the PC is switched off, the CPU 41x-2 PCI stores the current values of the 
STEP 7 user program in such a way that an automatic warm restart/hot restart 
is possible after Power On. 

• Operation with an external independent 24 VDC power supply and with a 
backup battery 

In this case, you can switch off the PC - the CPU 41x-2 PCI will continue 
running! 

The CPU 41x-2 PCI is independent of the PC. The PC can be switched off or 
can even fail, and the CPU 41x-2 PCI will continue running (uninterrupted 
power supply switchover). Here again, an automatic warm restart/hot restart is 
possible. 

 

Note 
In order to operate the CPU 41x-2 PCI independently of the PC, OB 84 must be 
programmed. If you have not programmed OB 84 and the PC is switched off or 
it crashes, the CPU 41x-2 PCI goes to STOP. 
For more detailed information, refer to .Responding to Diagnostic Events. 
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Restart Behavior of the CPU 41x-2 PCI after Power On of PC 
The restart behavior of the CPU 41x-2 PCI after Power On varies according to how 
you connected the CPU 41x-2 PCI to the power supply. The restart behavior of the 
CPU 41x-2 PCI after Power On of the PC depends on several factors: 

• Whether or not backup battery is available 

• Whether or not the CPU 41x-2 PCI is connected to an external independent 
power supply (UPS) 

• Type of memory card (FLASH card or RAM card) 

 
Independent 
24 VDC 
power supply 

Backup 
battery 

What happens after a Power Off/Power On of the 
PC? 

No No When the PC is powered off, the CPU 41x-2 
loses its power supply - a backup battery is not 
available, and the user program is aborted. 
A user program on the FLASH card is retained. 
All RAM contents (work and integrated load 
memory, RAM card) are lost. 
After the PC is powered on, the mode selector is 
on STOP and the CPU 41x-2 PCI performs an 
automatic memory reset and remains in STOP 
mode (cold restart). 

No Yes When the PC is powered off, the CPU 41x-2 PCI 
rescues the necessary data and goes to STOP 
mode in order to be ready for restart. RAM 
contents are retained.  
After the PC is powered on, the CPU 41x-2 PCI 
performs a warm restart/hot restart/cold restart or 
remains in STOP mode, depending on the 
parameter assignment and the mode selector 
setting. 

Yes Yes/No The CPU 41x-2 PCI continues running in spite of 
Power On/Power Off of PC. 
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2.3.2 When are the Warm Restart and Autoload Features Available? 

Autoload  
If the CPU 41x-2 PCI is not connected to an external 24 VDC power supply, you 
can use the Autoload feature to load user data.  

With the Autoload feature, the PC automatically retrieves a STEP 7 user program 
(stored in a file on the memory card) and loads the program onto the CPU 41x-2 
PCI following a Power Off/Power On. Then, the CPU 41x-2 PCI automatically 
selects the previously stored operating mode and executes the STEP 7 user 
program accordingly.  

The use of a backup battery, an independent 24 VDC supply, or a Flash Card 
precludes the use of the Autoload feature: 

• If you are using a backup battery, the STEP 7 user program is retained after 
Power Off/Power On. 

• If you connect the CPU 41x-2 PCI to an independent 24 VDC supply, the 
STEP 7 user program continues running or is retained after Power Off/Power 
On, depending on the error OB. 

• If you are using a FLASH card, the STEP 7 user program is automatically 
loaded from the FLASH card after Power Off/Power On. 

 
Independent 
24 VDC 
power supply 

Backup 
battery 

Memory card Warm restart 
possible after 
Power On of PC? 

Autoload 
feature 
available? 

RAM card/none No Yes No No 

FLASH card No No 

RAM card/none Yes No No Yes 

FLASH card Yes No 

RAM card/none CPU continues to 
be supplied from 
external 24 VDC 
power supply! 

No Yes No 

FLASH card CPU continues to 
be supplied from 
external 24 VDC 
power supply! 

No 

Yes Yes RAM card/none CPU continues to 
be supplied from 
external 24 VDC 
power supply! 

No 

  FLASH card CPU continues to 
be supplied from 
external 24 VDC 
power supply! 

No 
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Requirements for External Connection to 24 VDC  
If you connect the CPU 41x-2 PCI externally to an independent 24 VDC power 
supply, all of the 24 VDC supplied must be generated as safety extra-low voltage 
(SELV). 

The 24 VDC power supply must conform to LPS (Limited Power Source) or NEC 
Class 2. If the 24 VDC power supply does not conform to LPS or NEC Class 2, the 
CPU 41x-2 PCI must be operated in  restricted access locations. 

 

 

Warning 
Personal injury and property damage can occur. 
If you configure the 24 VDC supply for the CPU 41x-2 PCI incorrectly, 
components can be damaged and personal injury can result. 
The 24 VDC supply must satisfy the following requirements: 
Only extra-low voltage that is safely isolated from the supply system can be 
used. Safe isolation can be achieved, for example, by following the 
requirements in VDE 0100 Part 410 / HD 384-4-41 / IEC 364-4-41 (as 
functional extra-low voltage with safe isolation) or VDE 0805 / EN 60950 / IEC 
60950 (as safety extra-low voltage) or VDE 0106 Part 101. 

Cable for Connecting the 24 VDC to the CPU 41x-2 PCI 
The cable must comply with the following boundary conditions: 

• < 2 m: 0.5 mm2 to 2.5 mm2 cross section 

• > 2 m: 0.75 mm2 to 2.5 mm2 cross section  

Connecting the CPU 41x-2 PCI to an External 24 VDC Supply (Optional) 
1. A 2-pin connector equipped with a screw terminal is shipped with the CPU 41x-

2 PCI. 

Connect L+ to 24 VDC and M to ground (see slot bracket for marking). 

2. Insert the 2-pin connector onto the slot bracket of the CPU 41x-2 PCI. 
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2.4 Installing and Connecting the Backup Battery 

Use of a Backup Battery 
You must use a backup battery: 

• For backing up a user program that you want to store in a power failure-proof 
manner in RAM. 

• If you want to use the automatic warm restart/hot restart for the CPU 41x-2 
PCI. 

• If you want to retentively store bit memory, timers, counters, time-of-day, 
system data, and data in variable data blocks after Power Off/Power On. 

A lithium cell (AA size, 3.6 V) is used for the backup battery supply of the  
CPU 41x-2 PCI . 

 

 
Note 
The backup time of the supplied lithium cell is as follows: 
• CPU 412-2 PCI: 

- Typical backup time: 2900 hrs = 120 days 
- Minimum backup time (worst case): 1110 hrs = 46 days  

• CPU 416-2 PCI: 
- Typical backup time: 1610 hrs = 67 days 
- Minimum backup time (worst case): 740 hrs = 31 days 

The typical backup time is empirically derived based on the backup current, 
while the minimum backup time represents the sum of the values specified by 
the manufactures of the memory chips. 

 

 

Warning 
Danger of personal injury and property damage, danger of release of harmful 
substances. 
Incorrect handling can cause a lithium battery to explode, improper disposal 
of old lithium batteries can cause harmful substances to be released. 
Therefore, follow the instructions below without exception: 
• Do not throw batteries in fire or apply solder to the outside of the battery 

(maximum temperature of 100 °C). Likewise, do not recharge the 
batteries. There is a risk of explosion! 

• Do not open the battery. Always replace with a battery of the same type. 
Obtain replacement batteries from Siemens. This ensures that the battery 
will be short-circuit proof. 

• Whenever possible, provide old batteries to battery 
manufacturers/recyclers or dispose of them as hazardous waste. 
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Affixing the Battery Holder  
There are several options for affixing the backup battery to a battery holder on the 
PC: 

• Mount battery holder in place of a free slot bracket on the PC 

• Affix the battery holder to the PC housing 

• Box PC 627: affix battery holder to the PC 

 

 

Warning 
When opening the PC, always observe the relevant safety notes in the 
manual for the PC.  

 

Warning 
For safety reasons, the lithium battery may only be affixed in a location that is 
protected from mechanical damage. 

Battery Holder on the Slot Bracket 
You can mount the backup battery with the provided battery holder (slot bracket 
with cover) in place of a free slot in the PC (see figure below). 
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Battery Holder on PC Housing 
You can also affix the backup battery directly to the PC housing. To do so, unscrew 
the battery housing from the slot bracket and reseal it with the bracket provided 
(see figure below). Affix the sealed battery housing to the PC housing using two-
sided adhesive tape so that the connecting cable can still reach the CPU 41x-2 
PCI. 
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Connection of External Backup Battery Infeed 
Here, you can see the position of this interface on the slot bracket. 

 

 
A lithium cell (AA size, 3.6 V) is used for the backup battery supply of the  
CPU 41x-2 PCI . 

The WinAC Slot 41x package includes a battery pack with a suitable backup 
battery and a battery holder. 

A 2-pin, 4.95 mm socket is provided on the slot bracket of the CPU 41x-2 PCI for 
infeed purposes. This socket is available for an SO connector without sliding 
sleeve per DIN 45323 for connection of external power sources for battery-fed 
devices. 

However, the assignment does not correspond to DIN, i.e., the inner contact is the 
positive pole and the outer contact is the negative pole. As a result, a short circuit 
with the slot bracket of the CPU does not occur when the connector to the backup 
battery is removed/inserted. 
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Assigning the Connector 

 

Contact Assignment 

Inner Battery, positive 

Outer Battery, negative (M) 

For more information on the backup battery, refer to Removing the Passivation 
Layer of the Backup Battery. 

2.5 Connecting the Fan 
If you connect the CPU 41x-2 PCI to an external 24 VDC supply, you should feed 
the fan connection through the CPU 41x-2 PCI to ensure that it is adequately 
cooled even in the event the PC power supply fails: 

• If the PC supply voltage is switched on, the fan will operate, regulated by the 
PC. The fan rotation is regulated by the PC motherboard according to the 
temperature in the PC case (if the PC supports this mode). 

• If the PC supply voltage fails or you switch off the PC, the CPU 41x-2 PCI will 
take over the fan operation to prevent overheating. In this case, the fan is 
always operated at maximum rotation. 

Approved PC Fans 
Only UL-/CSA-approved fans within the technical specifications are permitted. 
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Connection Options 
There are three options for connecting the fan of the PC to the CPU 41x-2 PCI (X3, 
X4, or X5) - depending on the connector type. Together, the X3, X4 and X5 
connections provide a maximum of 500 mA at 12 V. The current for the fan is 
supplied from the PC motherboard or, if the PC is switched off, from the optional 
external 24 VDC supply.  
The X2 to X5 terminals are located on the smaller of the two printed circuit boards. 
The terminals have the following meaning: 
  

Terminal Meaning 
X2 Terminal for connection to the motherboard or power supply 
X3 Terminal for 3-pin or 4-pin connector from fan. Both types can 

be inserted. 
X4 Terminal for 2-pin connector from fan (depending on the 

connector type) 
X5 Terminal for 2-pin connector from fan (depending on the 

connector type) 

 

1. Remove the connector that is connected to the fan in the PC or is connected 
from the motherboard or power supply and connect it to X3, X4, or X5, 
depending on the connector type. 

2. Three fan cables are shipped with the product. Select the appropriate cable 
and insert it onto the terminal on the motherboard or power supply that has 
been made available. 

Use the 4-pin cable if the connection to the motherboard or the power supply is 
a 3-pin connection. 

3. Insert the other end of the cable onto X2 on the PC board of the CPU 41x-2 
PCI. 

Now, the PC fan will be operated by the CPU 41x-2 PCI, even if the PC is switched 
off. 

Connecting the Fan in Multi-Slot Operation 
If you are operating more than one CPU 41x-2 PCI, connect the fan to one of the 
CPUs 41x-2 PCI. 

 

 

Warning 
The CPU 41x-2 PCI, on which the fan is used always has to be connected to 
the external 24 VDC power supply. 
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2.6 Checks Before the Initial Turn-On of the PC with the 
CPU 41x-2 PCI 

Introduction 
After you have installed and wired your CPU 41x-2 PCI, we recommend that you 
check the steps you have performed thus far before you turn on the PC for the first 
time. 

Checks Prior to Initial Turn-On 
  

Checklist 

Is the CPU 41x-2 PCI properly inserted and screwed? 

Is a memory card inserted? 

Is the PC fan connected to the CPU 41x-2 PCI (optional)? 

Is the connector for the external 24 VDC supply (USP) infeed, if present, 
properly wired? 

Is the backup battery, if any, connected? 

Is the battery monitoring switch setting correct? 

 Initial Turn-On of PCs with the CPU 41x-2 PCI 
When you turn on the PC in which the CPU 41x-2 PCI is installed for the first time, 
the CPU automatically detects the PCI voltage.  

When shipped, the PCI voltage of the CPU 41x-2 PCI is set to 5 V. If a different 
PCI voltage is used in the PC, the CPU 41x-2 PCI will briefly switch back to STOP 
mode in many instances when turned on the first time. 
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2.7 Installation of WinAC Slot 41x Software 

2.7.1 Installing the WinAC Slot 41x Software 
Die WinAC Slot 41x software has a setup program for the CPU 412-2 PCI or CPU 
416-2 PCI. This setup program also installs the controller panel and WinAC Time 
Synchronization software components. 

System Requirements 
When installing the components of WinAC Slot 41x, you should observe the notes 
under System Requirements. 

Requirements 
Before you can install a software package, you must log on with Administrator 
rights. Otherwise, the Setup will be canceled. 

If an Older Version of WinAC Slot is Already Installed 
Prior to installation, you must always uninstall any older versions of WinAC Slot. 
For instructions on how to do this, refer to Uninstalling the WinAC Slot 41x 
Software. 

Installation Sequence 
If you are installing software packages individually, we recommend the following 
sequence: 

1. Install the following components using the general setup 

- SIMATIC WinAC CPU 41x-2 PCI (minimum) 

- WinAC Time Synchronization, if you want to synchronize the CPU 41x-2 
PCI using a SIMATIC CP or the PC clock. 

2. If necessary, STEP 7 or the hardware update of WinAC Slot for STEP 7 

3. If necessary, the SIMATIC Net CD for network components 

4. If necessary, WinCC or WinCC flexible 
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Installing the Components of WinAC Slot 41x 
The WinAC Slot 41x software includes a setup program that automatically performs 
the installation. 

The installation program leads you step by step through the installation operation. 
You can advance to the next step or return to the previous step at any time. 
Proceed as follows to access the installation program.  

1. Place the CD in the CD drive. 

2. Select the Setup.exe file by double-clicking it. 

3. Follow the instructions that appear on the next screen. 

 
4. Select the components to be installed. The setup automatically selects the 

components that were not found on the PC. 

If the installation was completed successfully, a corresponding message is 
displayed on the screen.  

5. Install the hardware update for the CPU 41x-2 PCI in the STEP 7 Hardware 
Configuration application by selecting Options > Install hardware updates.... 

 

 
Note 
If you want to use the SIMATIC NET OPC Server, you must install the 
provided SIMATIC NET CD. 
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Installation of Several WinAC Controllers (Ring Feature) 
During installation, the WinAC Slot software automatically detects how many 
WinAC Slot CPUs are installed. The WinAC controllers are automatically entered in 
the Station Configuration Editor. 

The Ring feature allows you to assign the controller panel of the CPU 41x-2 PCI: 

1. In the Windows taskbar, double-click the  symbol in order to access the 
Station Configuration Editor. 

2. Select the CPU 41x-2 PCI in the Station Configuration Editor. 

3. Select the Ring ON button or select the Ring ON command from the shortcut 
menu (right-click). 

Result: The SF-LED on the CPU 41x-2 PCI on the back of your computer and 
the FRCE-LED in the controller panel flash at 2 Hz. 

4. Select the Ring OFF button to terminate the "Ring" feature. 

Errors during Installation 
The following errors cause the installation to abort:  

• Not enough memory space: you need at least 120 MB of free memory space 
on your hard drive. 

• Defective CD: if you determine that the CD is defective, contact your Siemens 
representative. 

• No Administrator rights: Log on with Administrator rights. 
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2.7.2 Uninstalling the WinAC Slot 41x Software 
Note the following items before you start to uninstall the software: 

• The corresponding software components must not be in use when the software 
is uninstalled.   

Uninstalling the WinAC Slot 41x Software Components 
To uninstall the WinAC Slot 41x software on your computer, proceed as follows: 

1. Double-click the "Software" icon in Control Panel. 

2. Select one of the WinAC Slot 41x components to be uninstalled from the list of 
installed software. Click the Change/Remove button to uninstall the software. 

3. If the Remove Shared Files dialog appears, click No if you are unsure how to 
respond.  

4. Restart your PC. This removes the remainder of the files from the hard disk of 
your PC. 

 

Note 
Refer to the Readme files for the relevant software components. 
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3 Getting Started 

3.1 Definition of Terms 

3.1.1 What Is a PC Station? 
The PC station is a software-based virtual rack represented in the Station 
Configuration Editor that is used for creating a PC-based automation system. Like 
a hardware rack of an S7 CPU-based automation system, it contains space for 
several modules required for the PC-based automation system. 

When you install the WinAC Slot software, the controller appears by default in the 
third slot (index) of this virtual rack in the Station Configuration Editor. The PC 
Station is also represented in the STEP 7 Hardware Configuration editor.  

3.1.1.1 Communication Model with S7-400 
A PC-based controller is similar to an S7-400 hardware controller. The S7-400 
controller consists of modules in a rack that communicate over the backplane bus 
of the rack. Communications for an S7-400 are defined as follows: 

• STEP 7 communicates with the controller (in this example, an S7-400 
CPU module) over an MPI subnet, using a CP card that is installed in the 
computer. 

• The controller communicates with expansion modules over the backplane bus 
of the rack.  

• The S7-400 CPU communicates with distributed I/O over a PROFIBUS DP 
subnet using a built-in submodule interface or an IF module. 
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In an S7-400 station, the following types of communications are possible: 

Onboard Interfaces CP Modules used over Backplane Bus 

Operation of PROFIBUS DP/IO 
Supported interfaces: 
• MPI 
• PROFIBUS 

Operation of central I/O 
Supported communication processors: 
• PROFIBUS 
• Industrial Ethernet 

3.1.1.2 Communication Model with PC Station and PC-based Controller 
WinAC Slot and any other communications interfaces that are installed in the 
computer communicate over the virtual backplane bus. WinAC Slot communicates 
with the DP I/O through the DP interface or the MPI/DP interface. 

 

3.1.1.3 Configuration for a PC-based Controller 
You use the Station Configuration editor to configure components of the PC 
Station.  

In the same way that you use STEP 7 to create the system and program blocks for 
an S7-400, you use the STEP 7 Hardware Configuration tool to configure the 
components that you installed in the PC station.   

After you complete hardware configuration in STEP 7 you can download your 
STEP 7 user program to the controller.  
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3.1.2 What Is an Index? 
An index is a numbered slot in the virtual rack of the PC station. The PC-based 
controller occupies one index. The PC station contains other slots for the SIMATIC 
components of a PC-based controller, such as those listed below: 

• CP card(s) (requires installation of SIMATIC NET) 

• SIMATIC HMI  

• SIMATIC NET OPC Server (requires installation of SIMATIC NET) 

• WinLC RTX 

• WinLC Basis 

Each slot in the PC station corresponds to a number or index. When you install a 
CPU 41x-2 PCI, the setup program configures the controller in the third index slot 
by default. The Station Configuration Editor shows the configuration of your 
PC station.  

The index number for the CPU 41x-2 PCI must be between 2 and 18. However, the 
index number in the Station Configuration Editor must be the same as the slot 
number in the STEP 7 Hardware Configuration tool for the same component.  
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3.2 Configuring the Controller in STEP 7 

3.2.1 Hardware Configuration in STEP 7 
You configure the STEP 7 project for a PC station with a PC-based controller in 
STEP 7 as you would for any S7 hardware controller. Refer to the STEP 7 help 
system and documentation for detailed information.  

3.2.1.1 Creating the Project and PC Station with the SIMATIC Manager  
To create the project and PC station, follow these steps: 

1. Select the File > New menu command from the SIMATIC Manager to create a 
new project.  

2. Select the Insert > Station > SIMATIC PC Station menu command to insert a 
PC station into the project. 

3. Change the name of the PC station to match the name of the PC station 
defined in the Station Configuration Editor on the computer where the 
CPU 41x-2 PCI resides. To verify the station name, open the Station 
Configuration Editor and click the Station Name button. 
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3.2.1.2 Configuring the PC Station Hardware with the STEP 7 Hardware 
Configuration Application 
To configure the PC-based controller and DP I/O for the PC Station, follow these 
steps: 

1. Open the PC Station folder in the project and double-click the Configuration 
icon to invoke the STEP 7 Hardware Configuration application. 

2. Navigate to your specific controller under SIMATIC PC Station.  

 
3. Drag the controller into the same index it occupies in the Station Configuration 

Editor on the target computer.  

 
4. Verify that the name of the controller matches the name of the controller 

configured in the Station Configuration Editor. 

5. Configure the distributed I/O. 
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3.2.1.3 Additional Hardware Configuration Options 
The following tasks are optional, depending on your specific application: 

1. Insert any additional CPs needed for your application into the PC station.  

2. Insert any HMI devices, for example, text displays or operator panels. 

3. Configure the CPU 41x-2 PCI for peer-to-peer communications: 

- Select the controller name in the SIMATIC Manager. 

- Double-click the Connections icon in the right-hand pane. 

- Use NetPro to describe the network. 

After you have configured the CPU 41x-2 PCI you can use SIMATIC Manager to 
develop and to download your STEP 7 user program.  

3.2.2 Connecting STEP 7 to the Controller 
You must establish a connection from STEP 7 to the controller to download the 
configuration and blocks of the STEP 7 user program. This type of communication 
is called PG/OP communication. The controller can connect to STEP 7 in any of 
the following ways:  

• Through the virtual backplane bus to STEP 7 on the same computer as the 
controller 

• Through the MPI/DP interface to a CP on the computer with STEP 7 

• Through the DP interface to a CP on the computer with STEP 7 

• Through an Industrial Ethernet card configured in the PC Station of the 
computer with WinAC Slot to an Industrial Ethernet card on the computer with 
STEP 7 

Note: Configuring a communications interface in the PC Station requires the 
installation of SIMATIC NET, an additional software package.  
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3.2.2.1 Connecting STEP 7 to the Controller on the Same Computer 
On the same computer, STEP 7 and the controller communicate across the virtual 
backplane bus: 

 
To configure communications between the controller and STEP 7 on the same 
computer, use the PC internal access point: 
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3.2.2.2 Connecting STEP 7 to the Controller on a Different Computer 
WinAC Slot connects to STEP 7 on a different computer from either the MPI/DP 
interface or the DP interface of the CPU 41x-2 PCI to a communications interface 
on the other computer. WinAC Slot can also communicate to STEP 7 on a different 
computer through a communications interface configured in the PC Station. To 
configure a communications interface in the PC Station requires SIMATIC NET to 
be installed on your computer.  

 
To configure communications between the controller and STEP 7 on a different 
computer or programming device, set the PG/PC interface to the access point for 
the specific communications interface and the type of communications, for 
example, an Industrial Ethernet card using the TCP/IP protocol: 
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3.2.2.3 Connecting STEP 7 to a Networked Controller on a Different PC 
within the STEP 7 Project 
If you want to use STEP 7 to access a different controller in the same project, enter 
"PC internal" as the interface. 

With the PC internal interface, STEP 7 communicates to all controllers (S7 CPUs 
or PC-based controllers) that have been configured with NetPro in PC Stations in 
the STEP 7 project.  

3.3 Using the Station Configuration Editor to Configure PC 
Components within the PC 

Function of the Station Configuration Editor 
The Station Configuration Editor allows you to communicate the following settings 
to the PC: 

• Station name, maximum of 24 characters 

• Type of WinAC controller 

  

Note 
The settings in the Station Configuration Editor must agree with the subsequent 
configuration made in the STEP 7 Hardware Configuration application: 
• Station name 
• Type 
• Index (corresponds to the slot in "Hardware Config") 

Index 
The CPU 41x-2 PCI can be operated on an index from 2 to 18. The index 
corresponds to a virtual slot in the PC. 

Name of the WinAC Controller 
You can select any name for the controller in STEP 7 (default: CPU 41x-2 PCI). 
Only characters that can be used in file names are permitted. Leading blanks are 
not permitted.  

  

  
Note 
The name assigned to the controller in STEP 7  corresponds to the name 
that you use to access the controller panel of the PCU via the taskbar. For 
example, if you name the CPU 41x-2 PCI "Slot_PLC", you then access the 
controller panel via Start > Simatic > PC Based Control > Slot_PLC. 
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Opening the Station Configuration Editor 
To assign the name to the PC station, open the Station Configuration Editor by 
clicking the  symbol in the toolbar. 

Information on the Station Configuration Editor 
For more information, e.g., on diagnostics in the Station Configuration Editor, refer 
to the relevant online help. 

3.4 Commissioning 

3.4.1 Recommended Procedure for Commissioning 

Commissioning a PC with CPU 41x-2 PCI 
To commission a PC with a CPU 41x-2, we recommend the following procedure: 
1. Check again to make sure that the CPU 41x-2 PCI has been properly installed 

and parameterized (see checklist in Checks Before Initial Turn-On of the PC 
with CPU 41x-2 PCI) and that the WinAC Slot software package has been 
properly installed. 

2. Disconnect any DP line that is connected. 
3. Turn on the PC. 
4. Access the controller panel:  

Start > Simatic > PC Based Control > CPU 412-2 PCI V4or 
Start > Simatic > PC Based Control > CPU 416-2 PCI V4 

  

  
Note 
It is assumed in the following that you have saved the CPU 41x-2 PCI in the 
Station Configuration Editor under the name "CPU 412-2 PCI" or "CPU 
416-2 PCI". 

  
5. The following LEDs light up on the controller panel: 

- Green ON display 
- Yellow STOP display 
 
Check the backup battery and the position of the DIP Switch S1 on Switch 
Block S2 for suppression of battery monitoring if the red BATF display is lit as 
well. 
 
More up-to-date information about the controller panel, when available, is 
provided in the Readme file. You can access this Readme file in the following 
directory: 
 
Start > Simatic >  Product Info > English  
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6. Activate the RUN button on the controller panel. 
The STOP LED display goes out and the RUN LED display lights up. The CPU 
is now in RUN mode. 

7. Activate the STOP button on the controller panel. 
 
The RUN LED display goes out and the STOP LED display lights up. The CPU 
is now in STOP mode. 

8. If you want to test the internal supply through the PCI, you can remove the 
external power supply and check whether the CPU 41x-2 PCI continues to 
operate. 

9. Connect the CPU 41x-2 PCI step-by-step to the remaining components. 
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4 Operating the Controller - CPU 41x-2 PCI 

4.1 Turning On and Turning Off the Controller 
The controller operates independently from the controller panel:  

• Closing the panel (File > Exit menu command) does not turn off the controller.  

• Turning off the controller does not close the controller panel.  

The Autoload  feature affects the behavior of the controller when it is turned off and 
on.  

4.1.1 Powering On the CPU 41x-2 PCI  
If the controller panel is not open, select the Start > Simatic > PC Based Control 
menu command. Then select CPU 412-2 PCI, CPU 416-2 PCI or the name of the 
WinAC Slot PLC as configured in the Station Configuration Editor.  

When you power on the CPU 41x-2 PCI by selecting CPU > Power ON, it performs 
powerup initialization and goes to either STOP or RUN mode, depending on the 
previous setting, the mode selector switch position, and the setting in the Autoload 
option, if configured. 

When you power on the CPU 41x-2 PCI, it performs powerup initializations and 
goes to either STOP or RUN mode, depending on the previous setting, the mode 
selector switch position, and the setting in the Autoload option, if configured. 

Note: The CPU > Power ON menu command enables the functionality of the 
CPU 41x-2 PCI. The CPU 41x-2 PCI is already being supplied with working voltage 
by the power supply unit on the PC as well as from an external 24 VDC voltage 
supply. 

4.1.2 Turning Off the CPU 41x-2 PCI  
Select the CPU > Power Off menu command to turn off the CPU 41x-2 PCI. This 
action does not close the controller panel. This command is only available from the 
controller panel when the controller is operating. After you turn off the controller, 
you can still change customization options. 
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4.2 Restart Options for the Controller 

4.2.1 Selecting the Restart Method  
The restart method determines which startup OB the controller executes whenever 
a change from STOP mode to RUN mode occurs. The startup OB allows you to 
initialize your STEP 7 user program and variables. The CPU 41x-2 PCI 
supportsthree restart methods: 

• Warm restart: The controller executes OB 100 before starting the free cycle 
(OB 1). A warm restart resets the peripheral inputs (PII) and places the 
peripheral outputs (POI) into a pre-defined safe state (default is 0). A warm 
restart also saves the current value of the retentive memory areas for bit 
memory (M), timers (T), counters (C), and data blocks (DBs). 

• Hot restart: All data areas (timers, counters, bit memory, data blocks) and 
their contents are retained. The controller executes OB 101, reads in the 
process input image, and then continues processing the user program at the 
position where it was last stopped. A manual hot restart is only possible with 
STEP 7. 
Requirement You must enable the hot restart beforehand in STEP 7/HW 
Config. 

• Cold restart: The controller executes OB 102 before starting the free cycle 
(OB 1). Like a warm restart, a cold restart resets the peripheral inputs (PII) and 
changes the peripheral outputs (POI) to a pre-defined safe state (default is 0). 
A cold restart resets the retentive memory (M, T, and C) to their default values 
(DB). 

You specify the restart method to be performed automatically after Power 
Off/Power On in STEP 7. The automatic restart method is stored in the 
configuration (system data) for the controller that you download with your STEP 7 
user program. 

Whenever you click (using the left mouse button) the RUN mode selector position 
on the panel to change from STOP mode to RUN mode, the CPU 41x-2 PCI 
performs a warm restart, executing OB 100.  

To select a specific restart method, choose one of the following options to change 
the controller from STOP mode to RUN mode: 

• Select the CPU > RUN menu command to change the controller from STOP to 
RUN mode. 

• Right-click (using the right mouse button) the RUN mode selector switch 
position. 

Both of these actions display the Restart Method dialog that allows you to select 
either a warm or cold restart. 

 

Note 
If you have configured the confirmation security option, you must 
acknowledge a confirmation dialog before the controller panel displays the 
Restart Method dialog.  
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If you have configured a password as the security option and the password prompt 
interval is either 0 or has expired, the controller panel displays the Access 
Verification dialog for you to enter the password. After verifying successful 
password entry, the controller panel displays the Restart Method dialog. 

After executing OB 100 (warm restart) or OB 102 (cold restart) according to your 
selection, the controller executes the free cycle (OB 1). 

4.2.2 Setting the Autoload Feature 
You use the "Autoload" feature of WinAC Slot 41x to define how WinAC Slot 41x 
reacts to a Power Up of the PC. This feature is particularly useful during the 
commissioning phase of the automation system, or in unbuffered operation of the 
CPU 41x-2 PCI. The Autoload feature enables you to configure the controller to 
perform the following actions upon restart:  

• Load a STEP 7 user program that was previously archived  

• Set the operating mode to a defined state after loading the STEP 7 user 
program  

The topic Archiving and Restoring STEP 7 User Programs describes how to 
archive a STEP 7 user program that can be configured as the autoload program.  

To use the Autoload feature, your system must meet these requirements:  

• No FLASH card is plugged into the CPU 41x-2 PCI 

• The CPU 41x-2 PCI is operated without a backup battery  

• An external, independent 24 VDC supply is not connected 

• An archive file (.wld file) exists  
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The Autoload dialog is displayed.  

 
Use the following procedure to enable the Autoload feature:  

1. Select the CPU > Options > Customize menu command to display the 
Customize dialog.  

2. In the Customize dialog, select the Autoload tab.  

3. Select an archive file (.wld file) to load on restart.  

4. Select the operating mode to set for the controller on restart.  

5. Click OK to confirm your configuration. This closes the dialog.  
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4.2.3 Enabling a Warm Restart after Power On 
You can specify that the CPU 41x-2 PCI perform a warm restart after power on. 
When a warm restart is performed, the controller executes OB 100 and starts the 
user program from the beginning.  

Retentive data and the contents of data blocks are retained.  

For the controller to execute a warm restart, the following conditions must be met: 

• The CPU 41x-2 PCI has a backup battery. 

• Warm restart is configured in the Object Properties for the CPU 41x-2 PCI in 
STEP 7. 

4.2.4 Enabling a Hot Restart after Power On 
You can specify that the CPU 41x-2 PCI is to perform a hot restart after Power On. 
When a hot restart is performed, the controller executes OB 101 and reads the 
process input image and then continues processing the user program at the 
location where it was last stopped (due to STOP or Power Off).  

Retentive data and the contents of data blocks are retained.  

For the controller to execute a hot restart, the following conditions must be met: 

• The CPU 41x-2 PCI has a backup battery. 

• "Hot restart" is configured in the object properties for the CPU 41x-2 PCI in 
STEP 7. 
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4.3 Changing the Operating Mode of the Controller 
The controller panel provides a mode selector switch that allows you to change the 
operating mode of the controller. Set the mode selector switch to RUN or STOP (or 
select the appropriate command on the CPU menu) to change the operating mode 
of the controller either to RUN mode or STOP mode. 

The mode selector switch positions on the controller panel correspond to the mode 
selector switch positions of an S7 hardware controller: 

• RUN: The controller executes the STEP 7 user program.  

• STOP: The controller does not execute the STEP 7 user program. Outputs are 
set to their safe states. 

Specific controller actions are allowed or prohibited based on the operating mode.  

4.3.1 Operating Mode (RUN/STOP) and Status Indicators  
The mode selector switch on the controller panel functions like the manual mode 
selector switch on a S7 hardware controller allowing you to switch between RUN 
mode and STOP mode. 

 

 
 

<=> 

 

For both hardware controllers and PC-based controllers, the RUN and STOP 
status indicators show the current operating mode of the controller. If the status 
indicator shows a different operating mode than the mode selector switch position, 
the controller has changed operating mode, possibly due to some error in the 
program or because you used STEP 7 to change the operating mode. 
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4.3.2 Allowed and Prohibited Actions for each Operating Mode 
The operating mode allows or prohibits access to the controller for some types of 
operations as shown in the following table: 

Operating Mode Description 

RUN Allowed: 
• Downloading a program to the controller 
• Downloading individual blocks to the controller 
• Using STEP 7 to modify program variables  
• Performing a memory reset from either the 

controller panel or STEP 7  
• Changing the operating mode with STEP 7  
The controller automatically goes to STOP mode when 
you reset the memory using STEP 7.  
Not allowed: 
• Archiving and restoring a STEP 7 user program 

STOP Allowed: 
• Downloading a program or individual blocks to the 

controller 
• Using STEP 7 to modify program variables 
• Performing a memory reset from either the 

controller panel or STEP 7 
• Archiving and restoring a STEP 7 user program 
Not allowed: 
• Changing the operating mode with STEP 7 (if mode 

selector switch on STOP) 
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4.4 Resetting the Memory Area : MRES Command 
(CPU Menu) 
MRES performs a memory reset of the controller by resetting the controller to its 
initial (default) state. A memory reset deletes the STEP 7 user program and the 
system data (configuration) and also disconnects any online communications, for 
example, STEP 7, WinCC, WinCC flexible, PROFIBUS, or S7 communications.  

You typically perform an MRES before downloading a new program to the 
controller. You must perform a memory reset if the STOP indicator on the 
controller panel is flashing slowly. This can occur when:  

• CPU 41x-2 PCI has been inserted or moved in the Station Configuration Editor. 

• Memory card has been removed and inserted. 

Use one of the following methods to reset the memory:  

• Click the MRES button on the control panel 

• Select the CPU > MRES menu command  

• Press the ALT+C+M keys 

You can also use STEP 7 to perform a memory reset.  

MRES switches the controller to STOP mode, if necessary, and then performs the 
following tasks:  

• Deletes the entire STEP 7 user program (OBs, DBs, FCs, FBs, and the system 
data) from both the work memory area and the load memory area  

• The content of the memory areas (I, Q, M, T, and C) is reset to 0 (except for 
time of day). 

• System settings are reset to their default values (e.g., size of process image 
areas and size of diagnostic buffer).  

• Deletes all active communications jobs (for example, TIS) and all open 
communications 

• If a FLASH card is not inserted, the reset controller has a memory utilization of 
"0". The utilization can be read out with STEP 7. 
If a FLASH card is inserted, the controller copies the user program and the 
system parameters stored on the FLASH card onto the work memory area 
when the memory reset is complete. 

After MRES, the 120 most recent diagnostic buffer entries are retained. 

The STOP indicator flashes while the memory reset is in progress. After the 
memory has been reset, the diagnostics buffer is resized to its default size. Input (I) 
and output (Q) memory areas are also reset to their default sizes. After a memory 
reset, you must reconfigure these values to your own specifications. 
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4.5 Using the Status Indicators 
The status indicators on the control panel display the current operating mode and 
are helpful in troubleshooting an error condition. These indicators correspond to 
the LED indicators on a hardware S7 PLC.  

You cannot change the status of the controller by clicking the status indicators.  

If the control program reaches a break point set by the STEP 7 Program Editor, 
both the RUN and STOP indicators turn on while the breakpoint is active: the RUN 
indicator flashes, and the STOP indicator is on.  

During a change from STOP mode to RUN mode, the RUN indicator flashes, and 
the STOP indicator is on. When the STOP indicator turns off, the outputs are 
enabled.  

The table below describes the different status indicators for the control panel: 

Indicator Description 

ON Power supply. Lights up (solid) when you start the controller. Turns off 
when you power off the controller. 

BATF Battery fault.  

INTF This indicator lights up (solid) to show error conditions within the 
controller, such as programming errors, arithmetic errors, timer errors, 
and counter errors.  
If the STEP 7 user program handles the error by executing OB 80 or 
OB 121, the INTF indicator goes off after 3 seconds if there is no 
subsequent error condition. 

EXTF This indicator lights up (solid) to show error conditions that exist outside 
of the controller, such as hardware faults, parameter assignment errors, 
loss of communication or other communication errors, and I/O faults. 
If the STEP 7 user program handles the error by executing OB 122, the 
EXTF indicator goes off after 3 seconds if there is no subsequent error 
condition. 

BUSF1 
BUSF2 

These indicators light up (flashing) to identify fault conditions in the 
communication with the distributed I/O. BUSF1 corresponds to the 
MPI/DP communications interface and BUSF2 corresponds to DP. 

FRCE This indicator lights up (steady), if variables are being forced. A force job 
as configured in STEP 7 enables you to force variables of your choice to 
values that you specify. 

RUN 
STOP 

Lights up (solid) to show the operating mode (RUN or STOP). 
When RUN is flashing and STOP is lit (solid), the control program has 
reached a breakpoint. (RUN light flashes at 0.5 Hz.) 
Note: The RUN and STOP indicators show the actual operating mode of 
the controller. The RUN and STOP mode selector switch positions show 
the selected mode (similar to the mode selector switch position on an S7 
CPU front panel), which can differ from the current operating mode. For 
example: Changing the operating mode with STEP 7 causes the status 
indicators to change, but the mode selector switch does not change. 

Flashing Indicators 
Flashing patterns of the RUN and STOP indicators provide additional information 
about the controller or the STEP 7 user program: 
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Indicator 

RUN STOP 

Description 

flashing 
2 Hz 

flashing 
2 Hz 

The controller is in DEFECT mode. All status indicators are 
flashing (see Corrective Action if All Status Indicators are 
Flashing). 

flashing 
0.5 Hz 

on The STEP 7 user program halted at a breakpoint. 

flashing 
2 Hz 

on A warm restart or hot restart is in progress. The RUN indicator 
continues to flash until the restart completes. The time required 
for the restart operation depends on the time required to 
execute the startup OB. 

off flashing 
0.5 Hz 

The controller must be reset (MRES, see Corrective Action if 
the STOP Indicator is Flashing Slowly). 

off flashing 
2 Hz 

A memory reset (MRES) is being performed, see Corrective 
Action if the STOP Indicator is Flashing Slowly.  

4.5.1 Corrective Action if the STOP Indicator is Flashing Slowly 
If the STOP indicator flashes slowly, the controller requires a memory reset 
(MRES). To recover from this condition, you must use the MRES command to 
reset the controller. 

4.5.2 Corrective Action if All Status Indicators are Flashing 
If all of the status indicators are flashing at the same time, the controller is in a 
defective state and has encountered an error condition that cannot be fixed by 
resetting the memory with the MRES command. To recover from this condition, you 
must perform the following steps: 

1. Power off the controller.  

2. Power on the controller. The STOP indicator flashes with the RUN indicator off. 

3. Use the MRES command to reset the memory. 

4. Use STEP 7 to download the control program and system configuration, or to 
restore an archived control program. 

5. If either powering off or restarting the controller does not resolve the problem, 
you may need to reboot your computer. 
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4.6 Diagnostic Buffer Command (CPU Menu) 
Select the CPU > Diagnostic Buffer menu command to display the SIMATIC 
Diagnostic Buffer.  

The diagnostic buffer allows you to view system diagnostic information without 
having to access STEP 7. It consists of an upper panel that displays an event list 
and a lower panel that displays specific event details. 

 
The diagnostic buffer is implemented as a ring buffer that contains single event 
entries. The events are displayed in descending order by time, with the most recent 
event at the top. If the ring buffer is full, a new event overwrites the oldest entry in 
the buffer. 

The Diagnostic Buffer displays the following information: 

Event List (upper panel): A list of all the events in the diagnostic buffer. The 
following information is shown for each diagnostic event: 

• The number of the entry 

• The date and time of the event 

• A brief description of the event 

Event ID (between the upper and the lower panels): Displays the ID number of a 
selected event. 

• Event Details (lower panel): Displays the event details in either text or 
hexadecimal format.  

If you have chosen Text format, the following details about a selected event 
appear in the lower panel: 
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• A brief description 

Additional information, depending on the event, such as the address of the 
instruction that caused the diagnostic event and the mode transition that was 
caused by the event 

• The event state (incoming or outgoing) 

If a single parameter of text cannot be identified, the diagnostic buffer displays 
the string "###". If no text exists for new modules or new events, the event 
numbers and the single parameters are displayed as hexadecimal values. 

If you have chosen Hexadecimal format, the hexadecimal values of the 
selected event appear in the lower panel. 

4.6.1 Sorting Events (upper panel) 
You can sort the events listed in the upper panel by clicking the specific column: 

• Number (determined by time and date) 

• Event description 

4.6.2 Choosing Format (lower panel) 
You can display the diagnostic information in the lower panel in text or 
hexadecimal (Hex) format. In Hex format, the hexadecimal values of the 20 bytes 
of the selected event are displayed. To select the format: 

• Click Text to display the event details in text format.  

• Click Hex to display the hexadecimal values of the event. 

4.6.3 Time of Day including Time Difference CPU/Local 
If the check box is not active, the entries in the diagnostic buffer are stamped with 
the time of day on the module, for example, the CPU. You use this setting if this 
time is the same as the time at the location of the diagnostic buffer reader (the 
same time zone). 

If the check box is active, the correction value set for the time-of-day display is 
applied. You use this setting if the location of the diagnostic buffer reader is in a 
different time zone than the module. The check box can only be activated for 
modules which support time-of-day status. 

If you change the settings, the time entries in the diagnostic buffer are updated 
immediately. 

4.6.4 Updating the Diagnostic Buffer 
To display the most up-to-date information in the window, select the "Update" 
button. 
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4.6.5 Saving the Diagnostic Buffer 
To save a text file containing the event list and the detailed information for every 
event, click the Save button. The text file contains the information either in text or in 
hexadecimal format. 

4.6.6 Displaying Help 
To display help on the diagnostic buffer, click the Help button. To display help on a 
specific event: 

1. Select the event in the upper panel. 

2. Click the Help on Event button. 
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4.7 Archiving and Restoring STEP 7 User Programs 
The Archive from CPU command enables you to save the configuration and STEP 
7 user program to an archive file (*.wld). The archive file allows you to easily 
restore the configuration and STEP 7 user program for the controller. 

You can only archive or restore (Restore to CPU command) a STEP 7 user 
program when the controller is in STOP mode. You cannot archive or restore a 
STEP 7 user program when the controller is in RUN mode or is shut down.  

The archive file functions like the removable memory cartridge (EEPROM 
cartridge) of an S7 CPU; however, it differs in that the controller does not 
automatically restore the archive file after a memory reset (MRES). You must 
manually restore the archive file. 

Automatic Restart with Autoload Feature: You can also configure the CPU 41x-
2 PCI to load a specific archive file (*.wld) after restart. For this option, you must 
enable the "Autoload" feature and specify which archive file to load after restart. 

4.7.1 Creating an Archive File 
An Archive file stores the current STEP 7 user program, the current system 
configuration, and the current values of the DBs. The Archive file does not store 
the configuration of the PC station. 

To create an Archive file, select the File > Archive menu command. This 
command displays the Save As dialog, which allows you to give a name to the file. 
The controller then creates the archive file with the extension .wld. 

You can also use the SIMATIC Manager of STEP 7 to create an Archive file. Select 
the File > Memory Card File > New menu command.  

4.7.2 Restoring an Archive File 
When you restore an archive file, you reload the STEP 7 user program and the 
configuration for the controller. You can only restore archive files of extension .wld.  

Before you can restore an archive file, you must set the controller to STOP mode. 
Use the following procedure to load an archived configuration and STEP 7 user 
program: 

1. Click the STOP button to place the controller in STOP mode. 

2. Select the File > Restore to CPU menu command. 

3. Select the specific archive file to restore and click OK. 
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4.8 Closing the Controller Panel 
Select the File > Exit menu command to close the controller panel. 

Note: Closing the controller panel does not turn off the controller or affect the 
operating mode.  

4.9 Customizing and Security Options 

4.9.1 Customize Command (CPU Menu) 
To open the Customize dialog box, select the CPU > Options > Customize menu 
command. The tabs of the dialog box allow you to customize the controller panel 
as follows: 

4.9.1.1 General 
Select Always On Top to display the controller panel on top of all other open 
windows.  

4.9.1.2 Language 
You can change the display language for the controller panel menus and online 
help. 

To change the display language, follow these steps:  

1. To open the Customize dialog box, select the CPU > Options > Customize 
menu command.  

2. In the Customize dialog, select the Language tab. 

3. Select the language for the controller panel. 

4. Click Apply to change the language. 

5. Click OK to close the Customize dialog. 

The controller panel automatically changes to the selected language.  

4.9.1.3 Autoload 
WinAC Slot 41x features the Autoload function, which defines how WinAC Slot 41x 
reacts to a Power Up and Power Down of the PC. This feature is described in 
"Setting the Autoload Feature". 
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4.9.2 Setting the Security Options 

4.9.3 Security Command (CPU Menu) 
Select the CPU > Options > Security menu command to change security options. 
The controller panel displays the Access Verification dialog. You must enter your 
password in this dialog in order to make any changes to the security settings for 
the controller.  
Note: The default password is an empty field containing no characters. To enter the 
password the first time, press the Enter key.  

4.9.3.1 Security Level 
The Security dialog allows you to set levels of password security that limit access 
to the controller. The following security access options are provided: 

• Password: When you select Password, certain controller panel operations 
such as changing the operating mode and archiving and restoring a STEP 7 
user program, require that the user enter a password.  

• Confirmation: When you select Confirmation, operating mode changes 
require that the user acknowledge a confirmation dialog box. 

• None: When you select None, no confirmation or password is required.  

4.9.3.2 Password Prompt Interval 
You can set the Password Prompt Interval to a time interval of your choice, from 0 
to a maximum of 23 hours, 59 minutes. After you have entered your password, you 
are not prompted for it again until this time interval has expired. The default setting 
of 0 means that you must enter a password for each protected operation. 

Shutting down and starting the controller does not affect the expiration of the 
Password Prompt Interval; however, it is reset whenever you shut down the 
controller panel. The next time you start the controller panel and access a 
password-protected function, you will be prompted for password entry. 
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4.9.3.3 Change Password 
Click the Change Password button to display the Change Password dialog. 

Note: If you create a password, but set the security level to None (disabling the 
password), you still need to enter the configured password in the Access 
Verification dialog before you can access the Security dialog box again. 

  

 

Warning 
Running the controller without confirmation or password protection increases 
the risk that an operator may change the controller mode inadvertently, which 
could cause the process or equipment to operate unpredictably, resulting in 
potential damage to equipment and/or serious injury to personnel. 
Exercise caution to ensure that you do not inadvertently change the operating 
mode or permit unauthorized persons to access the machine or process. 
Always install a physical emergency stop circuit for your machine or process. 

4.9.4 Changing the Password 
The Change Password dialog allows you to change the current password.  

Note: The default password is an empty field containing no characters. To enter 
the password the first time, press the Enter key.  

Use the following procedure to change the password: 

1. In the Old Password field, enter the old password. 

2. In the New Password field, enter the new password (maximum length 12 
characters).  

3. In the Confirm New Password field, enter the new password again.  

4. Click OK to apply all the changes made in this dialog.  

To subsequently access the security options, you must enter the password at the 
Access Verification dialog.  
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4.10 Removing the Passivation Layer on the Backup Battery 
When lithium batteries (lithium/thionyl chloride) are used as backup batteries, the 
battery may not function immediately if the battery has been stored a long time and 
has developed a passivation layer. Under certain circumstances, this can cause an 
error message to be displayed after the CPU 41x-2 PCI is switched on. 
The CPU 41x-2 PCI is in the position of removing the passivation layer on the 
lithium battery through defined loading of the battery. This operation can take 
several minutes. When the passivation layer is removed and the lithium battery has 
reached its rated voltage, the error message can be acknowledged in the controller 
panel by selecting CPU > FMR. 
Since the storage time of the lithium battery is generally not known, we recommend 
the following procedure: 
1. Connect the backup battery to the BATT. socket on the slot bracket of the  

CPU 41x-2 PCI. 
2. Acknowledge any battery error message in the controller panel (BATF LED 

display) by selecting CPU > FMR. 
3. If the battery error cannot be acknowledged, repeat the acknowledgment 

attempt after a few minutes. 
4. If the battery error still cannot be acknowledged, remove the battery and short-

circuit it for 1 to 3 s. 
5. Apply the battery again and re-attempt the acknowledgment by selecting 

CPU > FMR. 
- If the display for the battery error message goes out, the battery is 

functional. 
- If the display for the battery error message does not go out, the battery is 

empty. 

  
Note 
If the power supply for the CPU 41x-2 PCI fails while you are changing the 
backup battery, the user program and data that you wanted to store 
retentively will be lost. 
Remedy: connect the CPU 41x-2 PCI to an additional external 24 VDC. 
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4.11 Update Firmware  
The File > Update Firmware menu command allows you to load updated firmware 
to the CPU 41x-2 PCI without a memory card. To do this, proceed as follows: 
1. You can either download the files with the firmware update from the internet or 

copy the files from an update CD to your PC.  
The firmware consists of three files with the extension *.upd.  

2. On the controller panel, select the File > Update Firmware menu command. A 
dialog box, which informs you about further steps to take, is displayed.  

3. In this dialog box, select the cpu_hd.upd file. 
4. Click OK. 
The firmware will be updated automatically. A progress bar informs you about the 
progress of the update. At the conclusion of the update, a new dialog is displayed 
indicating whether or not the update was successful. In addition, the new version of 
the firmware is displayed. 
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5 STEP 7 Operations and Components 

5.1 Using STEP 7 with the Controller 
STEP 7 provides programming and configuration tools for working with the CPU 
41x-2 PCI. You perform the following tasks with STEP 7: 

• Define the controller and DP I/O configuration through the STEP 7 Hardware 
Configuration tool 

• Develop a STEP 7 user program using any of the STEP 7 control programming 
languages 

• Configure operational parameters and I/O addresses for the controller 

• Download your configuration and STEP 7 user program to the controller 

Refer to your STEP 7 documentation for additional information. 

5.2 Configuring the Operational Parameters for the 
Controller  
STEP 7 provides a Hardware Configuration application for configuring the 
operational parameters for the controller. This configuration is then stored in 
various SDBs in the System Data container. 

After you download the System Data, the controller uses the configured 
parameters for the following events:  

• Whenever you power up the controller  

• On the transition to RUN mode (if you modified the hardware configuration 
online while the controller was in STOP mode)  

To configure the operational parameters from the STEP 7 Hardware Configuration 
application, right-click the controller entry in the station window and select Object 
Properties.  From the Properties dialog, you configure the operational parameters. 
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5.2.1 Accessing Operational Parameters 
To configure any of these operational parameters in STEP 7, open the 
SIMATIC Manager and follow these steps: 

1. In the SIMATIC Manager, select the PC station. 

2. Click the Configuration icon. 

3. Right-click the controller in the station window and select Object Properties. 

4. Click the tab with the name of the parameter that you want to configure (such 
as Cyclic Interrupt) and enter the appropriate values in the dialog. 

5. Click OK to confirm your configuration. 

Refer to your STEP 7 documentation for specific information about configuring the 
controller properties and the operational parameters. 
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5.3 Protection Levels 
With the CPU 41x-2 PCI, a protection level can be declared, by means of which the 
programs in the CPU can be protected from unauthorized access. The protection 
level is used to define which programming device functions a user can execute 
without having special authorization (password) on the relevant CPU. The 
password enables all programming device functions. 

Setting the Protection Levels 
You can set protection levels (1 to 3) for a CPU in the STEP 7 Hardware 
Configuration application. 

The protection level set in the STEP 7 Hardware Configuration application can be 
removed by performing a manual memory reset with the controls, provided a RAM 
card is inserted. The protection level selected for the user program is retained on 
the FLASH card. 

Protection levels 1 and 2 can also be set via the controls. 

The following table shows the protection levels of the CPU 41x-2 PCI: 

 
Protection 
Level 

Function Operating 
Mode Selector 

1 • All programming device functions are 
permitted (default setting). 

RUN/STOP 

2 • All functions for process control, process 
monitoring, and process communication are 
permitted. 

• All information functions are permitted. 
• Loading of objects from the CPU to the 

programming device is permitted, i.e., only 
read-accessing programming device 
functions are permitted. 

RUN 

3 • Neither read- nor write-accessing 
programming device functions are permitted. 

- 

If the protection level settings made with the mode selector and STEP 7 are 
different, the higher protection level prevails (3 over 2, 2 over 1). 
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5.4 Loading and Storing the STEP 7 User Program 

5.4.1 Load and Work Memory, Memory Card File 

Load and Work Memory 
When you load the STEP 7 user program to the CPU 41x-2 PCI, the code and data 
blocks are loaded to the load memory and work memory areas of the CPU 41x-2 
PCI. 

To ensure rapid processing of the STEP 7 user program, only those parts of the 
blocks that are relevant for program execution are loaded onto the work memory 
area. Block parts that are not required for program execution (e.g., block headers) 
remain in the load memory area. 

The following diagram illustrates loading of the program to the CPU memory: 

 

Structure of the Load Memory 
The load memory can be expanded through use of a memory card. Depending on 
whether you select a RAM card or a FLASH card for expanding the load memory, 
the behavior during loading, reloading, and resetting can differ. For more 
information on this topic, refer to Types of Memory Cards. 

Definition 
A memory card file represents the content of the memory card. The memory card 
file contains the STEP 7 user program and the hardware configuration (SDBs). 

• If you use STEP 7 to create the memory card file, the DBs will contain the 
initial values. 

• If you use the controller panel to create the memory card file with File > 
Archive CPU, the DBs will contain the current values. 
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5.4.2 Archiving and Restoring STEP 7 User Programs 
The memory card can only be removed and inserted when the PC is open. 
However, you have the option of reading STEP 7 user programs from the CPU 
41x-2 PCI or saving them to the CPU 41x-2 PCI without having to remove and 
insert the memory card: 

• The File > Archive from CPU command is used to load the STEP 7 user 
program and the hardware configuration from the load memory area of the 
CPU 41x-2 PCI to the PC (memory card file). 

• The File > Restore to CPU command is used to load a STEP 7 user program 
and the hardware configuration from the PC (memory card file) to the load 
memory area of the CPU 41x-2 PCI. 

• With the CPU > Options > Autoload command, the PC retrieves a memory 
card file that you have preselected and loads it onto the load memory area of 
the CPU 41x-2 PCI following a Power On. Then, the CPU 41x 2 PCI switches 
to the operating mode stored in the Memory Card file. 

Archiving from CPU 
The File > Archive function can be used to save the STEP 7 user program and the 
hardware configuration located on the CPU 41x-2 PCI to the PC. The controller 
panel reads out the load memory of the CPU 41x-2 PCI and stores this file with the 
extension *.wld on the hard disk. 

This file (memory card file) contains the STEP 7 user program and the current 
hardware configurations (SDBs). 

This function is also supported in SIMATIC Manager with File > Memory Card 
File. 
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Restoring to CPU 
The File > Restore to CPU command is used to load a STEP 7 user program and 
the hardware configuration from the PC to the load memory of the CPU 41x-2 PCI. 

First, select a memory card file with the extension *.wld and transfer it to the load 
memory of the CPU 41x-2 PCI. 

 

Autoload 
Application: you can use the Autoload feature to transfer a STEP 7 user program 
and the hardware configuration to the CPU 41x-2 PCI after the PC is powered on. 
This is primarily useful in the following cases: 

• During commissioning 

• During operation of the CPU 41x-2 PCI without battery backup 

Requirements: to utilize the Autoload feature 

• you must not have inserted a FLASH card in the CPU 41x-2 PCI 

• you must be operating the CPU 41x-2 PCI without a backup battery 

• An independent, external 24 VDC supply must not be connected. 
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The following figure shows the basic sequence of the Autoload feature: 

1. With the Autoload feature, you select a memory card file and the setting of the 
mode selector. 

2. Following a Power Off/ Power On of the PC, the PC loads the memory card file 
that you selected beforehand. 

3. Then, the PC writes this file to the load memory of the CPU 41x-2 PCI. 

4. Then, the CPU 41x-2 PCI starts the loaded memory card file and goes to the 
operating state specified in the memory card file (STOP, RUN). 
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6 Troubleshooting 

6.1 Error Detection via Status Indicators 
For the meaning of the LEDs on the controller panel, refer to Status Indicators. 

The LEDs on the slot bracket correspond to the status indicators of the LEDs on 
the controller panel : 

• SF corresponds to INTF and EXTF 

• R corresponds to RUN 

• S corresponds to STOP 

Troubleshooting Network Problems 
The controller panel provides the EXTF and BUSF status indicators that can be 
used to diagnose problems with the PROFIBUS-DP network. The table below 
describes the activity of the EXTF and BUSF indicators based on the particular 
error. In addition, possible remedies are provided. 

EXTF BUSF Description Action 
No 
configuration 

Ensure that the DP configuration has been 
entered into your STEP 7 project. Download 
the project's System Data container to the 
controller. 

Off Off 

Normal 
operation 

The configured DP slaves are responding. No 
action is required. 

Station failure Check to see that the bus cable is connected 
to the MPI/DP port of the CPU 41x-2 PCI and 
that all segments are correctly terminated at 
powered nodes.  
Check to see that the bus is not interrupted.  

On Flashing 

At least one of 
the DP slaves 
could not be 
accessed 

Wait for completion of the power-on cycle. If 
the indicator continues to flash, check the DP 
slaves or evaluate the diagnostic data for the 
DP slaves.  

— On Bus fault 
(hardware 
failure) 

Check the bus cable for an electrical short, or a 
broken wire or connection. 

On Off Diagnostic 
error 

Indicates that a fault condition has not been 
cleared or that a DP module with diagnostic 
capability has initiated OB 82.  

In addition to these visual indicators, you can use the Diagnose Hardware feature 
of the STEP 7 programming software to determine which nodes are experiencing 
problems and to determine the nature of the problem. 
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6.2 Responding to Diagnostic Events 
If an error is detected by the controller, the error condition is logged in the 
diagnostic buffer as a diagnostic event. The diagnostic events that are typically 
associated with distributed I/O can cause the controller to execute the following 
OBs :  

• OB 40 responds to hardware interrupts (process alarms) generated by an I/O 
module with configured interrupt capability. 

• OB 82 responds to diagnostic interrupts generated by an I/O module with 
configured diagnostic interrupt capability. 

• OB 83 responds to module removal/insertion at a DP Slave, (for example, ET 
200M), which has been configured for module pull/plug support. 

• OB 84 responds to CPU hardware faults or PC failure. With the CPU 41x-2 
PCI, causes include: 

- CPU hardware faults 

- PC is switched off, is starting up, or has crashed. For this reason, you must 
always program OB 84 so that the CPU 41x-2 PCI can be operated 
independently of the PC. 

• OB 85 responds to a priority class error. There are multiple causes for OB 85 
relating to the DP I/O system. If the controller attempts to copy a module's 
inputs to (or outputs from) the process image during the I/O cycle, and the 
module is not operational, then OB 85 is executed. 

• OB 86 responds to a station failure or some other interruption of the physical 
network (such as a short circuit).  

• OB 122 responds to an I/O access error by the user program. If OB 122 is not 
programmed, the controller goes to STOP mode.  

You can use SFC 39 to SFC 42 to disable, delay, or re-enable any of these OBs. If 
a non-loaded OB was requested, the controller goes to STOP mode. 

The local variables for these OBs contain restart information indicating the cause 
for executing the OB. The program for the OB can use this information for 
responding to the event. You can also use SFC 13 (DPNRM_DG) to read the 
diagnostic information from a DP slave. 

For information on using OBs and SFC 13, refer to the STEP 7 online help.  
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7 Getting Started: Communication between 
a CPU 416-2 PCI and an S7-400 

7.1 Preliminary Remarks on Getting Started 

Information Regarding Getting Started 
This section will familiarize you with how to work with WinAC Slot 41x using an 
example of establishing a connection. As part of these hands-on exercises, we will 
show you the most important dialogs and procedures.  

Familiarity with mouse operation, windowing systems, pull-down menus, etc., and 
basic knowledge about PLCs is also useful. 

Training courses are available in which you can add to the knowledge you have 
gained with Getting Started and learn how to create complete automation solutions 
with STEP 7. 

Requirements for Working with Getting Started 
To perform the hands-on exercises in this Getting Started, you need the following: 

• Siemens programming device or PC 

• STEP 7 software package and authorization diskette 

• SIMATIC S7-400 automation system 

  

The Getting Started section is organized as follows. 

1. Starting the Controller Panel of WinAC Slot 41x 

2. Task: Communication from the CPU 416-2 PCI over the CP 1613 to an S7-400 

3. Installing the Components of WinAC Slot 41x 

4. Station Configuration Editor 

5. Creating a Project in SIMATIC Manager 

6. Hardware Configuration for Box PC 840 

7. Hardware Configuration for S7-400 Station 

8. Configuring the Network 

9. Configuring a Connection 

10. Communication 

11. Going Online with STEP 7 to the CPU 41x-2 PCI 
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7.2 Problem Definition: Communication from the 
CPU 416-2 PCI over the CP 1613 to an S7-400 
In this example, a PC station containing a CPU 416-2 PCI will be connected to an 
SIMATIC S7-400 station via Industrial Ethernet (IE). 

 



Getting Started: Communication between a CPU 416-2 PCI and an S7-400 

Windows Automation Center, WinAC Slot Version 4.0 
Hardware Installation and Operating Manual, Edition 02/2006, A5E00273194-02 89 

7.3 Step 1: Installing the Components of WinAC Slot 41x 
 

The WinAC Slot 41x software includes a setup program that automatically performs 
the installation. 

The installation program leads you step by step through the installation operation. 
You can advance to the next step or return to the previous step at any time. 
Proceed as follows to access the installation program.  

1. Place the CD in the CD drive. 

2. Select the Setup.exe file by double-clicking it. 

Result: A dialog box is displayed where you can select the components you want 
to install. 

 
3. Select the components to be installed. The setup automatically selects the 

components that were not found on the PC. 

4. Continue with the remaining dialog boxes. 

If the installation was completed successfully, a corresponding message is 
displayed on the screen.  



Getting Started: Communication between a CPU 416-2 PCI and an S7-400 

 Windows Automation Center, WinAC Slot Version 4.0 
90 Hardware Installation and Operating Manual, Edition 02/2006, A5E00273194-02 

7.4 Step 2: Station Configuration Editor 

Function of the Station Configuration Editor 
The Station Configuration Editor allows you to communicate the following settings 
to the PC: 

• Station name 

• Type of CPU 41x-2 PCI 

• Adding CP 1613 

 

 
Note 
The following settings in the Station Configuration Editor must agree with the 
subsequent configuration made in the STEP 7 Hardware Configuration application: 
• Station name 
• Type 
• Index (corresponds to the slot in the STEP 7 Hardware Configuration application)  

Index 
The CPU 41x-2 PCI can be operated on an index from 2 to 18. The index 
corresponds to a virtual slot in the PC. 

Name of the CPU 41x-2 
You can select any name for the CPU 41x-2 PCI in STEP 7 (default: CPU 41x-2 
PCI). Only characters that can be used in file names are permitted. Leading blanks 
are not permitted.  

 
Note 

The name that you assign to the CPU 41x-2 PCI in STEP 7 
corresponds to the name that you use to access the controller panel 
of the CPU via the PC desktop. For example, if you name the CPU 
41x-2 PCI "Slot_CPU", you then access the controller panel via 
Start > Simatic > PC Based Control > Slot_CPU. 

Information on the Station Configuration Editor 
For more information, e.g., on diagnostics in the Station Configuration Editor, refer 
to the relevant online help. 
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Procedure 
1. To communicate the station name to the PC: 

2. Open the Station Configuration Editor by clicking the  symbol in the taskbar. 
Result: the Station Configuration Editor is displayed. 

3. Click on Station Name. 

4. Enter "Box PC 840" as the station name, and click OK. 

 

Adding CP 1613 
To add a CP 1613 to the station, proceed as follows: 

1. Select an available slot in the Station Configuration Editor. 

2. Click the Add button.  
Result: a list of inserted CPs and CPs not yet added to the station is 
displayed. 

3. Select the CP 1613 in the list. 

4. Confirm by clicking OK twice.  
Result: the component properties are displayed. 

5. Click OK. You specify the properties of the CP 1613 later in the STEP 7 
Hardware Configuration application. 

6. Click OK to exit the Station Configuration Editor. 
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7.5 Step 3: Creating a Project in SIMATIC Manager 
Proceed as follows: 

1. Create a project named "START_SLOT". 

2. Insert the Box PC 840 by selecting Insert > Station > SIMATIC PC-Station, and 
enter "Box PC 840" as the PC station name.  

3. Insert the S7-400 station by selecting Insert > Station > SIMATIC 400-Station, 
and enter "S7-400" as the SIMATIC S7-400 station name.  

 
 

 
Note 
The following settings in the Station Configuration Editor must agree with the 
subsequent configuration made in the STEP 7 Hardware Configuration application: 
• Station name (= Name of the PC station) 
• Type 
• Index (corresponds to the slot in the STEP 7 Hardware Configuration application) 
• Name. 
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7.6 Step 4: Hardware Configuration of the Box PC 840 

Selecting the Rack 
1. Select the Box PC 840. 

2. Double-click on Configuration to open HW Config. 

3. Open the catalog and navigate to SIMATIC PC Station > Controller > CPU 
416-2 PCI > 6ES7 616-2QL10-0AB4 > V4.0 

4. Use a drag-and-drop operation to insert the CPU 416-2 PCI onto Slot 3.  
 
Slot 3 corresponds to Index 3 in the Station Configuration Editor. The slot and 
the index must always be the same! 
 
Result: the Properties - PROFIBUS Interfaces DP Master dialog is displayed. 

5. Do not link the subnet for the DP master. 

6. Click OK. 
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Assigning the CP 
1. Navigate to SIMATIC PC Station > CP-Industrial Ethernet. 

2. Use a drag-and-drop operation to insert the CPU 1613 PCI on Slot 4. 

 
Slot 4 corresponds to Index 4 in the Station Configuration Editor. The slot and the 
index must always be the same! 
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Result: the Properties - Ethernet Interface CP 1613 dialog is displayed. 

 
 

3. Fill in the properties of the Ethernet interface according to the figure above 
(create a MAC address and new subnet), and click "OK". 

4. Click "Save and Compile" to close the dialog. 
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7.7 Step 5: Hardware Configuration of the S7-400 Station 
1. Select the components listed below and assemble them as shown in the figure 

below. 

- Rack 

- Power supply 

- CPU 416-2 

- CP 443-1  

 
2. Fill in the properties of the Ethernet interface (create a MAC address and new 

subnet) and click OK. 

3. Click "Save and Compile" to close the dialog.  

7.8 Step 6: Configuring a Network 
Open NetPro by clicking the Configure Network button. 

Result: the NetPro - [START_SLOT] window is displayed. 
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7.9 Step 7: Configuring a Connection 

Configuring a Connection 
A connection defines the communication relationship between two nodes. The 
following is specified as part of the connection: 

• The two communication nodes 

• The type of connection (in this case, an S7 connection) 

• Special properties that depend on the type of connection (e.g., whether a 
connection is permanently established or is dynamically set up and removed in 
the user program). 

To enter a connection, proceed as follows: 

1. Select the CPU 416-2 module (connection table is visible). 

2. Double-click on an empty row in the connection table, or select Insert > New 
Connection ...  
Result: the New Connection dialog is displayed. 
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3. In the Station and Module fields, select the programmable module to be 
connected with (connection partner or remote station indicated). 

4. Select the connection type (S7 connection only) in the Type field. 

5. Select the "Display properties before inserting" check box. 

6. Click Apply to confirm. The Properties - S7 Connection dialog is displayed. 

 
 

7. Check the settings (interface and type) based on the figure above. 

8. Click OK to confirm your entries. 

This creates the first connection.  

STEP 7 enters the connection in the connection table of the local node and assigns 
the local ID for this connection. If necessary, STEP 7 also assigns the partner ID 
that you need for programming the communication function blocks (value for the ID 
block parameter). 

These settings conclude the configuration of the START_SLOT project. 

9. Use the Save and Compile button to compile. 

10. Download the data to the respective station. 
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7.10 Step 8: Communication 
Integrate the appropriate communication blocks (e.g., Put/Get) into your user 
program. 

7.11  Going Online with STEP 7 to the CPU 41x-2 PCI 

Connecting STEP 7 to the CPU 41x-2 PCI on the Same Computer 
Proceed as follows if you want to configure STEP 7 for communication with the 
CPU 41x-2 PCI on the same computer. 

1. Open the interface tool in WinAC Slot using the following command: CPU > 
Set PG/PC Interface. 

2. Perform the following steps to set up STEP 7 as a local access point: 
– In the Access Point of the Application field, select S7ONLINE (STEP 7) (see 
figure). 
– In the Interface Parameter Assignment Used field, select "PC internal (local)" 
as the interface parameter. 
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STEP 7 is now configured for communication with the CPU 41x-2 PCI on the same 
computer. 

 

Connecting STEP 7 to the CPU 41x-2 PCI on A Different Computer 
You can connect STEP 7 to the CPU 41x-2 PCI located on another computer. You 
must define the network connection that STEP 7 and the CPU 41x-2 PCI 
communicate over by setting up the PG/PC interface on the remote computer.  
STEP 7 must be installed on the remote computer, and the CPU 41x-2 PCI must 
be installed on the computer to which you want to establish the connection.  
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Proceed as follows if you want to configure STEP 7 for communication with WinAC 
Slot on a remote computer. 
1. Access the interface configuration tool in SIMATIC Manager on the Options 

menu. 

 
2. In the Access Point of the Application field, select S7ONLINE (STEP7). 

- In the case of MPI communication, select an MPI interface, e.g., 
CP5611(MPI). 

- In the case of PROFIBUS DP communication, select a PROFIBUS DP 
interface, e.g., CP5611(PROFIBUS). 
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8 Getting Started : Connecting the Controller 
to the SIMATIC NET OPC Server 

The CPU 41x-2 PCI can use the SIMATIC NET OPC Server to read and write data 
over the network. You use the following tools to configure the OPC connection:  

• OPC Scout for configuring the connection to the SIMATIC NET OPC Server  

• STEP 7 (HW Config and NetPro) for configuring the CPU 41x-2 PCI 

• Station Configuration Editor for configuring the PC station 

Configuring an OPC Server connection requires the installation of SIMATIC NET.  

  
Note: The critical step most frequently overlooked is Step 3: Configuring the S7 
connection for the OPC server in NetPro. After adding the connection for the OPC 
server, you must set the connection type to "S7 connection" and enter a Local ID for 
the connection. 

8.1 Task Overview 

 Step 1:  Station Configuration Editor (SIMATIC NET)  
Add the OPC server to the PC station. 

 Step 2: HW Config (STEP 7)  
Add the OPC server to the hardware configuration in STEP 7. 

 Step 3: NetPro (STEP 7) 
Add an S7 connection for the OPC server to the configuration of the 
CPU 41x-2 PCI. 

 Step 4: SIMATIC Manager (STEP 7) 
Download the configuration to the controller 

 Step 5: OPC Scout (SIMATIC NET)  
Connect the controller to the OPC server. 
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8.2 Step 1: Add the OPC Server to the PC Station 

Tool:  Station Configuration Editor (SIMATIC NET) 

To configure the OPC server in the PC Station, follow these steps: 

1. Open the Station Configuration Editor and select any index in the Station 
Configuration Editor.  

2. Right-click the mouse to display the Add button. Click the Add button to display 
the Add Component dialog.  

3. Select "OPC Server" from the drop-down list of component types:  

 
4. Click OK to add the OPC server to the station configuration. The Station 

Configuration Editor displays the OPC server in the index selected. (For this 
example, the OPC server is configured for Index 1.) 
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5. Click OK to save the PC station configuration and to close the Station 
Configuration Editor dialog.  

 

8.3 Step 2 : Add the OPC Server to the Hardware 
Configuration 

Tool:  HW Configuration (STEP 7) 
Task Summary: 
• Create a STEP 7 project for a PC station with a CPU 41x-2 PCI. 
• Insert the OPC server into the hardware configuration. 
• Configure the OPC server. 
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8.3.1 Creating the STEP 7 Project 
1. Open STEP 7 and create a project (for example, OPCProject). 

2. Insert a SIMATIC PC Station with the same name as entered in the Station 
Configuration Editor.  

3. Double-click the Configuration icon for the PC Station to open the STEP 7 
Hardware Configuration application. 

4. Insert the CPU 41x-2 PCI in the same index as configured in the Station 
Configuration Editor.  
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Adding the OPC Server to the Hardware Configuration 

1. Expand the User Application folder in the Hardware Catalog.  

2. Expand the OPC Server folder and select the following component:  

3. SW V6.3  

4. Drag and drop the SW V6.3 component to the same index as configured in the 
Station Configuration Editor. (For this example, the OPC server is configured 
for Index 1.) 

 



Getting Started : Connecting the Controller to the SIMATIC NET OPC Server 

 Windows Automation Center, WinAC Slot Version 4.0 
108 Hardware Installation and Operating Manual, Edition 02/2006, A5E00273194-02 

8.3.2 Configuring the OPC Server 
1. Double-click the OPC Server entry (Index 1) to open the Properties dialog. 

2. Click the S7 tab and select the Activate option (under Access Protection). 

3. To use the STEP 7 symbols for accessing controller data from the OPC 
Server, select the option for All (or for Selected, to specify specific entries in 
the symbol table) under the Use Symbols field.  

4. Click OK to close the Properties dialog. 

5. Click the Save and Compile icon to create the hardware configuration for the 
PC station.  

 

After you have compiled the configuration into the STEP 7 project, you can close 
HW Config and return to SIMATIC Manager. 
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8.4 Step 3: Add an S7 Connection for the OPC Server in 
NetPro 

Tool:  NetPro (STEP 7)  
Task Summary: 
• Configure an S7 connection for the OPC server to the PC Station 

configuration. 
• Assign a Local ID for the OPC server connection. 

8.4.1 Configuring an OPC Server Connection in NetPro 
1. In SIMATIC Manager, browse to the OPC server and double-click the 

Connections icon to open NetPro. 

 
2. Select the OPC Server in the PC station.  
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3. Right-click the OPC server to display the context menu. Select the Insert New 

Connection menu command to open the Insert New Connection dialog. 
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4. Set the connection type to S7 connection and click OK to add the 

S7 connection for the OPC server. The Properties dialog for the S7 connection 
opens automatically. 
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8.4.2 Assigning a Local ID for the OPC Server Connection 
1. In the Properties dialog, enter the Local ID for the S7 connection (such as 

OPC_1). 

2. Click OK to add the S7 connection to NetPro.  

3. Click the Save and Compile icon to save and compile your changes into the 
STEP 7 project. 

 
After you have compiled the S7 connection for the OPC server into the STEP 7 
project, you can close NetPro and return to SIMATIC Manager. 
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8.5 Step 4: Download the Configuration to the Controller 

Tool:  SIMATIC Manager (STEP 7) 
Note: The controller must be running in order to download the configuration 
from STEP 7. 

To download the configuration, follow these steps: 

1. If the controller is not running, power it on. 

2. In SIMATIC Manager, select the SIMATIC PC Station icon. 

3. Select the PLC > Download menu command or click the Download icon on the 
toolbar. 

 

8.6 Step 5 : Connect the Controller to the OPC server 

Tool: OPC Scout 
Task Summary: 
• Create an OPC Project. 
• Add the connection to the SIMATIC NET OPC server. 
• Define the items to be accessed through the OPC server. 

8.6.1 Creating an OPC Project 
Select the Start > SIMATIC >SIMATIC NET > OPC SCOUT menu command to 
create a new project in OPC Scout.  
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8.6.2 Adding a Connection (Group) for the OPC Server 
To add a connection to the SIMATIC NET OPC server, follow these steps: 

1. Expand the Local Server(s) directory in the Servers and Groups for the project.  

2. Double-click the OPC.SimaticNet element to add a connection (or group) for 
the SIMATIC NET OPC server.  

 
3. In the Add Group dialog, enter the Group Name for the connection (for 

example, Group1). 

 
4. Click OK to add the group to the OPC server. OPC Scout adds the connection 

(Group1) to the OPC server. 
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8.6.3 Configuring the Items to be Accessed (Using Absolute 
Addressing)  
Note: This procedure describes how to use absolute addressing when configuring 
the OPC server. You can also use the STEP 7 symbol table to connect the OPC 
server. This procedure is described in "Configuring the Items to be Accessed 
(Using the STEP 7 Symbol Table)". 

Use the following procedure to configure the OPC server to use an absolute 
address for accessing data in the controller: 

1. Open the OPC Navigator by double-clicking the connection (Group1) for the 
OPC server. 

 
2. To add an item to be accessed, expand the \S7: folder and select OPC_1. 
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3. To configure access to M 0.0, expand the Objects folder and expand the M 

folder (for the bit memory area).  

 
4. Double-click the New Definition icon to open the Define New Item dialog. 

5. To define a connection for M0.0, select X (for bit) from the Data Type drop-
down list and enter the byte address (0) and bit number (0). (You can also 
enter an alias for the item.) 
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6. Click OK to define an item for M0_0. 

 
7. Select the MX0.0 entry and click the Add arrow (-->) to enter the following 

syntax that defines a connection for MX0.0: 

S7:[OPC_1]MX0.0 

8. Select the entry (S7:[OPC_1]MX0.0) and click OK to add the connection for 
MX0.0 to Group1.  
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After adding the item to Group1, OPC Scout displays name and other parameters 
for the item. You can now use any of the methods supported by SIMATIC NET 
OPC Server. 
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8.6.4 Configuring the Items to be Accessed (Using the STEP 7 
Symbol Table) 
If you created a symbol table for the STEP 7 program that you downloaded, you 
can use the symbols for connecting the OPC server to the data in the controller. To 
configure the items to be accessed using the STEP 7 symbol table, follow these 
steps: 

1. Open the OPC Navigator by double-clicking the connection (Group1) for the 
OPC server. 

2. Browse to the folder for the controller to display the symbols that have been 
downloaded to the controller. 

 
3. After selecting the symbols for the data to be connected to the OPC server, 

click the Add button (-->). 

 
4. Click the OK button to add the symbol  to Group1. 
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After adding the item to the group, OPC Scout displays symbol name and other 
parameters for the STEP 7 symbol.  
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9 Reference Information 

9.1 General Technical Specifications 

9.1.1 Standards, Certificates, and Approvals 

Introduction 
This section presents information on 

• The primary standards met by the modules 

• Certificates and approvals for the modules 

CE Mark 
Our modules satisfy the requirements of EC Directive 89/336/EWG 
"Electromagnetic Compatibility" (EMC Directive). 

The EC Declarations of Conformity are held for the relevant authorities at: 

Siemens Aktiengesellschaft 
Automation Group 
A&D AS RD ST 
P.O. Box 1963 

D-92209 Amberg 

Area of Application 
SIMATIC products are designed for use in industrial settings.  

 
Area of Application Requirements 

 Interference emission Interference immunity 
Residential, business, 
and commercial 
operations as well as 
small businesses 

EN 6100-6-3: 2001 EN 6100-6-1: 2001 

Industrial EN 6100-6-4: 2001 EN 6100-6-2: 2001 

 
Test Environment 

All technical specifications were proven in the SIMATIC Box PC 627 test 
environment. 
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Approvals 
The CPU 41x-2 PCI has the following approvals: 

 

 
 

Underwriters Laboratories (UL) in accordance to  

• Standard UL 60950, File-No. E115352 and Canadian Standard C22.2 No. 
60950 (I.T.E) and  

• Standard UL 508, File-No. E85972 and Canadian Standard C22.2 No. 14 05 
(IND.CONT.EQ) 

9.1.2 Electromagnetic Compatibility 

Definition 
The CPU 41x-2 PCI satisfies the requirements of the applicable European 
standards if set up according to the guidelines thereof. 

The modules have been tested in a device that likewise complies with the 
standards indicated below. If the modules are operated in a device that does not 
comply with these standards, adherence to the relevant values cannot be 
guaranteed. 

Information on interference immunity and radio interference suppression is 
provided below. 
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Pulse-Shaped Interferences 
The following table presents the electromagnetic compatibility of modules with 
respect to pulse-shaped interferences. This presupposes that the system complies 
with the specifications and guidelines on electrical installation. 

 
Pulse-Shaped Interference Tested with Correspond-

ing Severity 

Electrostatic discharge in 
accordance with  
IEC 61000-4-2 

Air discharge: ± 8 kV 
Contact discharge: ± 6 kV 

3 

Burst pulses in accordance with 
IEC 61000-4-4 

2 kV 3 

High-energy surge in 
accordance with IEC 61000-4-5 
• Asymmetrical interference 

  
 
• Symmetrical interference 

   
  
2 kV (supply line) DC voltage with 
protectors 
2 kV (data line) 
1 kV (supply line) DC voltage with 
protectors 

3 

Sinusoidal Interferences 
The following table presents the EMC behavior with respect to sinusoidal 
interferences: 

 
Sinusoidal 
Interference 
 

Tested with Corresponding 
Severity 

HF radiation 
(electromagnetic fields) 
in accordance with IEC 
61000-4-3 

10 V/m with 80% amplitude 
modulation of 1 kHz over the range 
of 80 MHz to 1000 MHz and 1,4 GHz 
to 2 GHz 

3 

Conducted RF 
interference on cables 
and cable shields in 
accordance with IEC 
61000-4-6 

Test voltage of 10 V with 80% 
amplitude modulation of 1 kHz over 
the range of 10 KHz to 80 MHz 

3 

Emission of Radio Interferences 
Radio interference in accordance with EN 55022: Limit Class B. 

Performing Work on the Prod 
To protect the product from discharge of static electricity, operating personnel must 
take appropriate action to discharge static electricity from their bodies prior to 
touching the module. 
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9.1.3 Shipping and Storage Conditions 

Modules 
The modules meet the shipping and storage condition requirements of IEC 61131, 
Part 2. The following specifications apply to modules that are shipped and stored in 
their original packaging. 

The climatic conditions conform to Class 2K4 for shipping and storage. 

The mechanical conditions conform to IEC 60721, Part 3-2, Class 2M2. 

  
Type of condition Permissible range 

Free fall ≤ 1 m (up to 10 kg) 

Temperature From - 40 °C to + 70 °C 

Air pressure 1080 to 660 hPa (corresponds to an 
altitude of -1000 to 3500 m) 

Relative humidity 5 to 95%, without condensation 

Sinusoidal vibrations in accordance 
with IEC 60068-2-6 

5 to 9 Hz: 3.5 mm 
9 to 500 Hz: 9.8 m/s2 

Shock in accordance with  
IEC 60068-2-29 

250 m/s2 6 ms, 1000 shocks 

Shipping of Backup Batteries 
Whenever possible, backup batteries should be shipped in their original packaging. 
No special measures are required for shipping backup batteries. The lithium 
content of the backup battery is less than 0.5 g. 

Storage of Backup Batteries 
Backup batteries must be stored in a cool, dry environment. Maximum storage time 
is 10 years. 

  

 

Warning 
Danger of personal injury and property damage. Danger of release of harmful 
substances. 
Incorrect handling can cause a lithium battery to explode, improper disposal of old 
lithium batteries can cause harmful substances to be released. Therefore, follow the 
instructions below without exception: 
• Do not throw new or discharged batteries in fire, and do not apply solder to the 

outside of the battery (maximum temperature of 100 °C). Likewise, do not 
recharge the battery. There is a danger of explosion! 

• Do not open the battery. Always replace with a battery of the same type. Obtain 
replacement batteries through Siemens - this ensures that your battery will be 
short-circuit-proof. 

• Return old batteries to the battery manufacturer or dispose of them as hazardous 
waste. 
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 Passivation Layer 
When lithium batteries (lithium/thionyl chloride) are used, the battery may not 
function immediately if the battery has been stored a long time and has developed 
a passivation layer. For remedies, refer to Removal of the Passivation Layer of the 
Backup Battery. 

9.1.4 Mechanical and Climatic Environmental Conditions  

Operating Conditions 
The modules have been tested in a device that likewise complies with the 
standards indicated below. If the modules are operated in a device that does not 
comply with these standards, adherence to the values cannot be guaranteed. 

Usage with Additional Measures Only 
The CPU 41x-2 PCI must not be used without additional measures being taken 

• At locations subject to a high degree of ionizing radiation  

• At locations with harsh operating conditions; for example, due to 

- Dust 

- Corrosive vapors or gases 

- Strong electrical or magnetic fields 

• In facilities requiring special monitoring, such as  

- Lifts 

- Electrical systems in particularly hazardous areas 

An additional measure might be operation in an enclosure or cabinet. 

Mechanical Environmental Conditions 
The SIMATIC Box PC 627 is designed to meet stringent requirements for 
mechanical environmental conditions (vibration test with 1 g constant load at a 
frequency of 58 to 500 Hz). The CPU 41x-2 PCI complies with these requirements 
when operated in a SIMATIC Box PC 627. 

If the CPU 41x-2 PCI is installed in other PCs with longer slots than 3/4 PCI and 
greater mechanical stresses, you must mechanically secure the back end of the 
PCB. 
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Requirement for External 24 VDC Power Supply 
The 24 VDC power supply must conform to LPS (Limited Power Source) or NEC 
Class 2. If the 24 VDC power supply does not conform to LPS or NEC Class 2, the 
CPU 41x-2 PCI must be operated in  restricted access locations. 

Tests for Mechanical Environmental Conditions  
The following table provides information on the type and scope of the tests for 
mechanical environmental conditions. 

 
Test for Test Standard Remarks 

Vibrations Vibration test in 
accordance with  
IEC 60068 Part 2-6  
(sine) 

Vibration type: Frequency sweeps 
with change rate of 1 
octave/minute. 
10 Hz ≤ f < 58 Hz, constant 
amplitude of 0.075 mm 
58 Hz ≤ f < 500 Hz, constant 
acceleration of 1 g 
Vibration period: 10 frequency 
sweeps per axis in each of 3 
mutually perpendicular axes 

Shock Shock test in accordance 
with 
IEC 60068 Part 2-29 

Type of shock: Half-sine 
Intensity of shock: 5 g peak value, 
30 ms duration 
Shock direction: 100 shocks in 
each of 3 mutually perpendicular 
axes 
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Climatic Environmental Conditions 
The modules may be used under the following climatic environmental conditions: 

 
 Permissible range Remarks 

Temperature 5 to +60 °C Temperature measured 
on the CPU 41x-2 PCI 
The CPU 41x-2 PCI 
functions in the complete 
approved temperature 
range as the Box PC 627. 

Temperature change Max. 10 °C/h  

Relative humidity Max. 95% at +25 °C No condensation, 
corresponds to RH Class 
2 in accordance with IEC 
61131-2 

Air pressure 1080 to 795 hPa 
(corresponds to an 
altitude of -1000 to 
2000 m) 

 

Pollutant 
concentration 

 
SO2: < 0.5 ppm; 
RH < 60%, no 
condensation 
H2S: < 0.1 ppm; 
RH < 60%, no 
condensation 

Test: 
10 ppm; 4 days 
  
1 ppm; 4 days 
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9.1.5 Certifications for USA, Canada, and Australia 

9.1.5.1 USA 
Federal Communications Commission  

Radio Frequency Interference Statement  

This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his 
own expense: 

Shielded cables  

Shielded cables must be used with this equipment to maintain compliance with 
FCC regulations. 

Modifications  

Changes or modifications not expressly approved by the manufacturer could void 
the user's authority to operate the equipment. 

Conditions of operations  

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that 
may cause undesired operation. 

9.1.5.2 Canada 
Canadian Notice  

This Class B digital apparatus complies with Canadian ICES-003. 

Avis Canadien  

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du 
Canada. 

9.1.5.3 Note for Australia 

 

WinAC Slot 41x satisfies the requirements of AS/NZS CISPR 22 (Class B). 
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9.2 CPU 41x-2 PCI: Technical Specifications 

9.2.1 Overview of Parameters for the CPU 41x-2 PCI 

Introduction 
The properties and behavior of the CPU can be assigned. System data blocks 
contain parameter blocks that define the behavior of the operating system and 
CPU-internal initial settings. 

Default Values 
All parameters are set to default values when the product is shipped. These default 
values are suitable for a wide range of standard applications and enable the  
CPU 41x-2 PCI to be used directly without additional settings. 

Assignable System Characteristics 
The following list presents an overview of the assignable system characteristics 
that are available in the CPU 41x-2 PCI.  

• General properties 

• Startup 

• Cycle/clock memory 

• Retentivity 

• Local data 

• Interrupts (process interrupts, time-delay interrupts, asynchronous error 
interrupts) 

• Time-of-day interrupts 

• Cyclic interrupts 

• Synchronous cycle interrupts 

• Diagnostics/clock 

Parameter Assignment Tool 
The individual CPU parameters can be set in the STEP 7 Hardware Configuration 
application. 
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9.2.2 Performance Features and Technical Specifications of the 
CPU 412-2 PCI 
 

Product version 

HW product version 01   

Firmware version V4.0   

 
Voltages and currents 

19 W With external 24 VDC 
supply and switched-off 
PC 

11 W With external 24 VDC 
supply and switched-on 
PC 

Power consumption 

10 W With supply from the PC 

Power loss, max. 11 W  

Load from fan 
connection, max. 

500 mA In addition, note the 
maximum load capacity 
of the fan infeed coming 
from the PC!  

Requirements for external 24 VDC supply 

• Static 20.4 to 28.8 V  

• Dynamic 18.5 to 30.2 V 3-phase bridge rectifier 

 
Current consumption 

1.0 A From external 24 VDC 
supply 

0.8 A From PCI interface (5 V) 

Current consumption, 
max. 

0.4 A From PCI interface (12 V) 

Backup battery 

Voltage 3.6 V Lithium 

Backup current, max. 1.3 mA Backup battery voltage: 
3.6 V, Lithium; 2.3 Ah 

Backup current, typ. 500 µA  
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Memory/backup 

Memory 

Memory card, 
FLASH EPROM 

  For technical 
specifications, see Types 
of Memory Cards 

Work memory 

Integrated (for 
program) 

192 Kbytes  

Integrated (for 
data) 

192 Kbytes  

Load memory 

Expandable 
FEPROM 

Yes  Memory card (FLASH) 

Expandable 
FEPROM, max. 

64 Mbytes  

Integrated RAM, 
max. 

256 Kbytes  

Expandable RAM Yes  Memory card  

Expandable 
RAM, max. 

64 Mbytes  
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CPU/blocks 

DB 

Number, max. 511   

Size, max. 64 Kbytes  

FB 

Number, max. 256   

Size, max. 64 Kbytes  

FC 

Number, max. 256   

Size, max. 64 Kbytes  

OB 

Number, max. 29   

Size, max. 64 Kbytes  

Number of time-
of-day interrupt 
OBs 

2   

Number of time-
delay interrupt 
OBs 

2   

Number of cyclic 
interrupts 

2   

Number of 
hardware 
interrupt OBs 

2   

Nesting depth 

Per priority class 24   

Additional tiers 
within an error 
OB 

1   

 
CPU/execution times 

For bit 
operations, min. 

0.1 µs  

For fixed-point 
arithmetic, min. 

0.1 µs  

For floating-point 
arithmetic, min.  

0.3 µs 
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Timers/counters and their retentivity 

S7 counters 

Number 2048   

Retentivity 

Adjustable Yes   

Lower limit 0   

Upper limit 2047   

Preset Z 0 to Z 7   

Counting range 

Adjustable Yes   

Lower limit 0   

Upper limit 999   

IEC counter 

Available Yes   

Type SFB   

 
S7 timers 

Number 2048   

Retentivity 

Lower limit 0   

Upper limit 2047   

Preset No retentive 
timers 

  

Time setting range 

Lower limit 10 ms  

Upper limit 9990 s  

IEC timer 

Available Yes   

Type SFB   
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Data storage areas and their retentivity 

Retentivity 
without UPS 

None   

Retentivity with 
UPS 

None   

Retentivity with 
battery 

All data  Total work and load 
memory (with backup 
battery) 

Bit memory 

Number 4 Kbytes  

Retentive bytes MB 0 to MB 
4095 

  

Retentivity preset MB 0 to MB 
15 

  

Amount of clock 
memory 

8   

 
Address area 
Total I/O address area 
Inputs 4 Kbytes  
Outputs 4 Kbytes  
Distributed outputs 
MPI/DP interface, 
inputs 

2 Kbytes  

MPI/DP interface, 
outputs 

2 Kbytes  

DP interface, 
inputs 

4 Kbytes  

DP interface, 
outputs 

4 Kbytes  

Process image 
Inputs, adjustable 4 Kbytes  
Outputs, 
adjustable 

4 Kbytes  

Inputs, preset 128 Bytes  
Outputs, preset 128 Bytes  
Number of 
process image 
partitions, max. 

15   

Digital channels 

Inputs 32768   

Outputs 32768   
Analog channels 

Inputs 2048   

Outputs 2048   
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Configuration  
Number of DP masters 

Total  2   

Integrated 2   

 
Time of day 

Clock 

Real-time clock Yes   

Battery-backed Yes   

Operating hours counter 

Number 8   

Time synchronization 

Supported Yes   

With PC-CP, 
slave 

Yes   

With MPI, master Yes   

With MPI, slave Yes   
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S7 message functions 

Number of 
stations that can 
be logged on for 
message 
functions, max. 

8   

SCAN procedure Yes   

Process 
diagnostic 
messages 

Yes   

Alarm-8 blocks Yes   

Control system 
fault messages 

Yes   

 
Test and commissioning functions 

Status/Force 

Status/Force 
Variable 

Yes   

Force 

Force Yes   

Status block Yes   

Single step Yes   

Diagnostic buffer 

Available Yes   

Number of inputs, 
max. 

400   

Preset 120   
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1st interface 

Type of interface RS 485 / 
PROFIBUS 

  

Power supply on 
interface from 5 V, max. 

90 mA  

Physical level RS 485   

Optically isolated Yes   
Functionality 

MPI Yes   

DP master Yes   

DP slave Yes   
MPI 

Number of connections 16   
Services 

PG/OP communication Yes   

Routing Yes   

Global data 
communication 

Yes   

S7 basic communication Yes   

S7 communication Yes   

Transmission rates, max. 12 Mbps  
 
DP master 

Number of connections, 
max. 

16   

Services 

PG/OP communication Yes   

Routing Yes   

Global data 
communication 

No   

S7 basic communication Yes   

S7 communication Yes   

Equidistance support Yes   

SYNC/FREEZE Yes   

Enable/disable DP 
slaves 

Yes   

Direct data exchange Yes   

DPV0 Yes   

DPV1 Yes   

Transmission rates, max. 12 Mbps  

Number of DP slaves, 
max. 

32   

Address area 
Inputs, max. 2 Kbytes  
Outputs, max. 2 Kbytes  
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1st interface 
User data per DP slave 
Inputs, max. 244 Bytes  
Outputs, max. 244 Bytes  
 
DP slave 

PG/OP communication Yes   

Routing Yes   

Status/Force Yes   

Programming Yes   

Transmission rates 12 Mbps  
Transfer memory 

Inputs 244 Bytes  

Outputs 244 Bytes  

Address areas, max. 32   

User data per address 
area, max. 

32 Bytes  

Amount of consistent 
user data per address 
area, max. 

32 Bytes  
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2nd interface 

Type of interface RS 485 / 
PROFIBUS 

  

Power supply on 
interface from 5 V, max. 

90 mA  

Physical level RS 485   

Optically isolated Yes   
Functionality 

MPI No   

DP master Yes   

DP slave Yes   

PROFINET CBA No   

PROFINET CBA-SRT No   

PROFINET IO controller No   
 
DP master 
Number of connections, 
max. 

16   

Services 

PG/OP communication Yes   

Routing Yes   

Global data 
communication 

No   

S7 basic communication Yes   

S7 communication Yes   

Equidistance support Yes   

SYNC/FREEZE Yes   

Enable/disable DP 
slaves 

Yes   

Direct data exchange Yes   

DPV0 Yes   

DPV1 Yes   

Transmission rates, max. 12 Mbps  

Number of DP slaves, 
max. 

64   

Address area 
Inputs, max. 4 Kbytes  
Outputs, max. 4 Kbytes  
User data per DP slave 
Inputs, max. 244 Bytes  
Outputs, max. 244 Bytes  
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2nd interface 
DP slave 
Services 

PG/OP communication Yes   

Routing Yes   

Status/Force Yes   

Programming Yes   

Transmission rates 12 Mbps  
Transfer memory 
Inputs 244 Bytes  
Outputs 244 Bytes  

Address areas, max. 32   

User data per address 
area, max. 

32 Bytes  

Amount of consistent 
user data per address 
area, max. 

32 Bytes  

 
Clock synchronization 

Isochronous mode Yes   

Number of DP masters 
with clock 
synchronization 

2   

User data per 
isochronous slave, max. 

244 Bytes  

Maximum number of 
bytes and slaves in a 
process image partition 

  The following must be true: 
number of bytes/100 + 
number of slaves < 16 

Equidistance Yes   

Minimum clock cycle 1 ms  

Maximum clock cycle 32 ms  
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CPU/programming 

Configuring software 

STEP 7 Yes V5.3 SP2 and 
higher 

 

Programming language 

STEP 7 Yes   

LAD Yes   

FBD Yes   

STL Yes   

SCL Yes   

CFC Yes   

GRAPH Yes   

HiGraph® Yes   

Software libraries 

Easy Motion 
Control 

Yes   

Nesting levels 8   

User program 
protection/password 

Yes   

Open development interfaces 

CCX (custom code 
extension) 

No   

SMX (shared 
memory extension) 

Yes  With WinAC ODK V4.1 

Inputs 4 Kbytes  

Outputs 4 Kbytes  

CMI (Controller 
Management 
Interface) 

Yes  With WinAC ODK V4.1 

 
Dimensions and weight 

Width 288 mm  

Height 98 mm  

Depth 18.5 mm  

Required slots 1  PCI, format 3/4 

Weight, approx. 300 g  
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Hardware requirements 

Required 
hardware 

PC with color 
monitor, 

keyboard, 
mouse or 

pointing 
device for 
Windows 

  

Memory 
requirement on 
hard disk, min. 

60 Mbytes  

Main memory, 
min. 

256 Mbytes  

Processor Intel Pentium 
300 MHz 

  

Multi-processor 
system 

Yes   

Hyperthreading Yes   

 
Software requirement 

Operating system 

Windows NT 4.0 No   

Windows 2000 Yes  Professional, SP3 and 
higher 

Windows XP Yes  Professional, SP1 and 
higher 
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9.2.3 Performance Features and Technical Specifications of the 
CPU 416-2 PCI 

 

Product version 

HW product 
version 

01   

Firmware 
version 

V4.0   

 
Voltages and currents 

19 W With external 24 VDC 
supply and switched-off PC 

11 W With external 24 VDC 
supply and switched-on PC 

Power 
consumption 

10 W With supply from the PC 

Power loss, max. 11 W  

Load from fan 
connection, max. 

500 mA In addition, note the 
maximum load capacity of 
the fan infeed coming from 
the PC!  

Requirements for external 24 VDC supply 

• Static 20.4 to 28.8 V  

• Dynamic 18.5 to 30.2 V 3-phase bridge rectifier 

 
Current consumption 

1.0 A From external 24 VDC 
supply 

0.8 A From PCI interface (5 V) 

Current 
consumption, 
max. 

0.4 A From PCI interface (12 V) 

Backup battery 

Voltage 3.6 V Lithium 

Backup current, 
max. 

1.95 mA Backup battery voltage: 
3.6 V, Lithium; 2.3 Ah 

Backup current, 
typ. 

900 µA  
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Memory/backup 

Memory 

Memory card, 
FLASH EPROM 

  For technical 
specifications, see Types 
of Memory Cards 

Work memory 

Integrated (for 
program) 

1.6 Mbytes  

Integrated (for 
data) 

1.6 Mbytes  

Load memory 

Expandable 
FEPROM 

Yes  Memory card (FLASH) 

Expandable 
FEPROM, max. 

64 Mbytes  

Integrated RAM, 
max. 

256 Kbytes  

Expandable RAM Yes  Memory card  

Expandable 
RAM, max. 

64 Mbytes  
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CPU/blocks 

DB 

Number, max. 4095   

Size, max. 64 Kbytes  

FB 

Number, max. 2048   

Size, max. 64 Kbytes  

FC 

Number, max. 2048   

Size, max. 64 Kbytes  

OB 

Number, max. 52   

Size, max. 64 Kbytes  

Number of time-
of-day interrupt 
OBs 

8   

Number of time-
delay interrupt 
OBs 

4   

Number of cyclic 
interrupts 

9   

Number of 
hardware 
interrupt OBs 

8   

Nesting depth 

Per priority class 24   

Additional tiers 
within an error 
OB 

2   

 
CPU/execution times 

For bit 
operations, min. 

0.08 µs  

For fixed-point 
arithmetic, min. 

0.08 µs  

For floating-point 
arithmetic, min.  

0.48 µs 
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Timers/counters and their retentivity 

S7 counters 

Number 2048   

Retentivity 

Adjustable Yes   

Lower limit 0   

Upper limit 2047   

Preset Z 0 to Z 7   

Counting range 

Adjustable Yes   

Lower limit 0   

Upper limit 999   

IEC counter 

Available Yes   

Type SFB   

 
S7 timers 

Number 2048   

Retentivity 

Lower limit 0   

Upper limit 2047   

Preset No retentive 
timers 

  

Time setting range 

Lower limit 10 ms  

Upper limit 9990 s  

IEC timer 

Available Yes   

Type SFB   
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Data storage areas and their retentivity 

Retentivity 
without UPS 

None   

Retentivity with 
UPS 

None   

Retentivity with 
battery 

All data  Total work and load 
memory (with backup 
battery) 

Bit memory 

Number 16 Kbytes  

Retentive bytes MB 0 to 
MB 16383 

  

Retentivity preset MB 0 to 
MB 15 

  

Amount of clock 
memory 

8   
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Address area 

Total I/O address area 

Inputs 16 Kbytes  

Outputs 16 Kbytes  

Distributed outputs 

MPI/DP interface, 
inputs 

2 Kbytes  

MPI/DP interface, 
outputs 

2 Kbytes  

DP interface, 
inputs 

8 Kbytes  

DP interface, 
outputs 

8 Kbytes  

Process image 

Inputs, adjustable 16 Kbytes  

Outputs, 
adjustable 

16 Kbytes  

Inputs, preset 512 Bytes  

Outputs, preset 512 Bytes  

Number of 
process image 
partitions, max. 

8   

Digital channels 

Inputs 12800   

Outputs 12800   

Analog channels 

Inputs 8000   

Outputs 8000   
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Configuration  

Number of DP masters 

Total  2   

Integrated 2   

 
Time of day 

Clock 

Real-time clock Yes   

Battery-backed Yes   

Operating hours counter 

Number 8   

Time synchronization 

Supported Yes   

With PC-CP, 
slave 

Yes   

With MPI, master Yes   

With MPI, slave Yes   
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S7 message functions 

Number of 
stations that can 
be logged on for 
message 
functions, max. 

12   

SCAN procedure Yes   

Process 
diagnostic 
messages 

Yes   

Alarm-8 blocks Yes   

Control system 
fault messages 

Yes   

 
Test and commissioning functions 

Status/Force 

Status/Force 
Variable 

Yes   

Force 

Force Yes   

Status block Yes   

Single step Yes   

Diagnostic buffer 

Available Yes   

Number of inputs, 
max. 

3200   

Preset 120   
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1st interface 
Type of interface RS 485 / 

PROFIBUS 
  

Power supply on 
interface from 5 V, max.  

90 mA  

Physical level RS 485   

Optically isolated Yes   
Functionality 

MPI Yes   

DP master Yes   

DP slave Yes   
MPI 

Number of connections 44   
Services 

PG/OP communication Yes   

Routing Yes   

Global data 
communication 

Yes   

S7 basic communication Yes   

S7 communication Yes   

Transmission rates, max. 12 Mbps  
 
DP master 
Number of connections, 
max. 

32   

Services 

PG/OP communication Yes   

Routing Yes   

Global data 
communication 

No   

S7 basic communication Yes   

S7 communication Yes   

Equidistance support Yes   

SYNC/FREEZE Yes   

Enable/disable DP slaves Yes   

Direct data exchange Yes   

DPV0 Yes   

DPV1 Yes   

Transmission rates, max. 12 Mbps  

Number of DP slaves, 
max. 

32   

Address area 
Inputs, max. 2 Kbytes  
Outputs, max. 2 Kbytes  
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1st interface 

User data per DP slave 
Inputs, max. 244 Bytes  
Outputs, max. 244 Bytes  
 
DP slave 

PG/OP communication Yes   

Routing Yes   

Status/Force Yes   

Programming Yes   

Transmission rates 12 Mbps  
Transfer memory 

Inputs 244 Bytes  

Outputs 244 Bytes  

Address areas, max. 32   

User data per address 
area, max. 

32 Bytes  

Amount of consistent 
user data per address 
area, max. 

32 Bytes  
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2nd interface 

Type of interface RS 485 / 
PROFIBUS 

  

Power supply on 
interface from 5 V, max. 

90 mA  

Physical level RS 485   

Optically isolated Yes   
Functionality 

MPI No   

DP master Yes   

DP slave Yes   

PROFINET CBA No   

PROFINET CBA-SRT No   

PROFINET IO controller No   
 
DP master 
Number of connections, 
max. 

32   

Services 

PG/OP communication Yes   

Routing Yes   

Global data 
communication 

No   

S7 basic communication Yes   

S7 communication Yes   

Equidistance support Yes   

SYNC/FREEZE Yes   

Enable/disable DP 
slaves 

Yes   

Direct data exchange Yes   

DPV0 Yes   

DPV1 Yes   

Transmission rates, max. 12 Mbps  

Number of DP slaves, 
max. 

125   

Address area 
Inputs, max. 8 Kbytes  
Outputs, max. 8 Kbytes  
User data per DP slave 
Inputs, max. 244 Bytes  

Outputs, max. 244 Bytes  
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2nd interface 

DP slave 
Services 

PG/OP communication Yes   

Routing Yes   

Status/Force Yes   

Programming Yes   

Transmission rates 12 Mbps  
Transfer memory 

Inputs 244 Bytes  

Outputs 244 Bytes  

Address areas, max. 32   

User data per address 
area, max. 

32 Bytes  

Amount of consistent 
user data per address 
area, max. 

32 Bytes  
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Clock synchronization 

Isochronous mode Yes   

Number of DP 
masters with clock 
synchronization 

2   

User data per 
isochronous 
slave, max. 

244 Bytes  

Maximum number 
of bytes and 
slaves in a 
process image 
partition 

  The following must be true: 
number of bytes/100 + 
number of slaves < 40 

Equidistance Yes   

Minimum clock 
cycle 

1 ms  

Maximum clock 
cycle 

32 ms  
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CPU/programming 

Configuring software 

STEP 7 Yes V5.3 SP2 and 
higher 

 

Programming language 

STEP 7 Yes   

LAD Yes   

FBD Yes   

STL Yes   

SCL Yes   

CFC Yes   

GRAPH Yes   

HiGraph® Yes   

Software libraries 

Easy Motion 
Control 

Yes   

Nesting levels 8   

User program 
protection/password 

Yes   

Open development interfaces 

CCX (custom code 
extension) 

No   

SMX (shared 
memory extension) 

Yes  With WinAC ODK V4.1 

Inputs 4 Kbytes  

Outputs 4 Kbytes  

CMI (Controller 
Management 
Interface) 

Yes  With WinAC ODK V4.1 

 
Dimensions and weight 

Width 288 mm  

Height 98 mm  

Depth 18.5 mm  

Required slots 1  PCI, format 3/4 

Weight, approx. 300 g  
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Hardware requirements 

Required 
hardware 

PC with color 
monitor, 

keyboard, 
mouse or 

pointing 
device for 
Windows 

  

Memory 
requirement on 
hard disk, min. 

60 Mbytes  

Main memory, 
min. 

256 Mbytes  

Processor Intel Pentium 
300 MHz 

  

Multi-processor 
system 

Yes   

Hyperthreading Yes   

 
Software requirement 

Operating system 

Windows NT 4.0 No   

Windows 2000 Yes  Professional, SP3 and 
higher 

Windows XP Yes  Professional, SP1 and 
higher 
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9.3 Memory Cards 

9.3.1 Memory Cards: Design and Function 

Design 
The memory card is somewhat larger than a credit card and is protected by a 
robust metal housing. It is inserted into a slot on the CPU; the insertion direction is 
determined by the design of the memory card.  

 

Function 
The memory card along with an integrated memory area on the CPU printed circuit 
board form the load memory of the CPU. During operation, the load memory can 
contain the following elements: 

• Complete user program including comments, symbols, and supplementary 
information that permits decompilation of the user program 

• All module parameters  

To utilize the CPU memory completely, you should use a memory card with more 
memory capacity than the work memory of the CPU. 

What is Stored on the Memory Card? 
The memory card can store the following data: 

• User program, i.e., blocks (OBs, FBs, FCs, DBs) 

• Parameters that define the behavior of the CPU 

• Parameters that define the behavior of I/O modules 
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9.3.2 Types of Memory Cards 
You can use two types of memory cards: 

• RAM card or 

• FLASH card (FEPROM card) 

 

 

Caution 
Do not use non-system memory cards in the CPU 41x-2 PCI! 

Which Type of Memory Card Should You Use? 
Whether you use a RAM card or a FLASH card depends on how you want to use 
the memory card.  

 
If ... Then ... 

You store the data in RAM and want to change your 
program even during RUN mode. 

Use a RAM card 

You want to save your user program permanently 
on the memory card even when the power is turned 
off (without battery backup or external to the CPU). 

Use a FLASH card 

 

Differences between RAM Card and FLASH Card 
 

RAM Card FLASH Card 

The RAM card must be inserted in 
the CPU in order to load the user 
program. The user program is loaded 
with the aid of the programming 
device (PG). 

You have two options for loading the 
user program: 
Switch the CPU to STOP with the 
mode selector, insert the FLASH 
card into the CPU, and load the user 
program onto the load memory area 
with the aid of the programming 
device. 
Load the user program onto the 
FLASH card in offline mode on the 
programming device and then insert 
the FLASH card into the CPU. 
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RAM Card FLASH Card 

You can load the entire user program 
or individual portions thereof (e.g., 
FBs, FCs, OBs, DBs, or SDBs) onto 
the load memory area in STOP 
mode or RUN mode. 

You can only reload your user 
program in its entirety. You can 
reload small portions of your user 
program to the load memory area 
integrated in the CPU with the aid of 
the programming device. If changes 
involve large portions of your 
program, you have to reload the 
entire user program onto the FLASH 
card. 

If you remove the RAM card from the 
CPU, the stored information will be 
lost. In addition, the CPU prompts 
you to perform a memory reset. The 
RAM card does not have an 
integrated backup battery. 
If an external backup voltage is fed 
to the "BATT." socket, the contents 
of the RAM card are retained after 
the PC has been switched off as long 
as the RAM card remains inserted in 
the CPU. 

The FLASH card does not need 
voltage to store its contents -- in 
other words, the information 
contained on the card is retained if 
you remove the FLASH card from the 
CPU or operate your system without 
a backup battery (without external 
backup voltage at the "BATT." 
socket. 

 

What Memory Card Capacity Should You Use? 
The capacity of the memory card you use depends on the scope of the user 
program and the additional memory requirement resulting from the use of function 
modules and communication modules. You can estimate the memory requirement 
for these modules with STEP 7. 
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Changing a Memory Card 
 

 

Warning 
The memory card can only be removed and inserted when the PC is open. 
The memory card can also be replaced while the CPU 41x-2 PCI is 
operating. 
Replacement of the memory card while the CPU 41x-2 PCI is operating is 
allowed only when the manufacturer of the PC authorizes the PC to be 
opened while the PC is energized. 
Make sure that you do not touch any live parts when a PC is open! 

 

You can replace the memory card when the power is turned off and while the CPU 
41x-2 PCI is running. 

To change the memory card, proceed as follows: 

1. Click the STOP option. 

2. Remove the inserted memory card. 

3. Insert the memory card into the slot on the CPU and push it in as far as it will 
go. 
 
Result: The STOP indicator on the CPU flashes slowly (0.5 Hz), indicating that 
a memory reset is required. 

4. Click the MRES option. 
 
Result: The STOP display flashes for at least 3 second at 2 Hz (memory is 
being reset) and then changes to a steady-light signal. 
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Technical specifications for memory cards 
Dimensions WxHxD (in mm)  7.5 x 57 x 87 

Weight  Max. 35 g 

EMC protection  Incorporated into design 

Memory card-specific data 
Current consumption at 5 V Buffer currents Name 

Typ. Max. Typ. Max. 
MC 952 / 64 KB / RAM 20 mA 50 mA 0.5 µA 20 µA 

MC 952 / 256 KB / RAM 35 mA 80 mA 1 µA 40 µA 

MC 952 / 1 MB / RAM 40 mA 90 mA 3 µA 50 µA 

MC 952 / 2 MB / RAM 45 mA 100 mA 5 µA 60 µA 

MC 952 / 4 MB / RAM 45 mA 100 mA 5 µA 60 µA 

MC 952 / 8 MB / RAM 45 mA 100 mA 5 µA 60 µA 

MC 952 / 16 MB / RAM 45 mA 100 mA 5 µA 60 µA 

MC 952 / 64 MB / RAM 100 mA 150 mA 100  µA 500 µA 

MC 952 / 64 KB / 5V FLASH 15 mA 35 mA - - 

MC 952 / 256 KB / 5V FLASH 20 mA 45 mA - - 

MC 952 / 1 MB / 5V FLASH 40 mA 90 mA - - 

MC 952 / 2 MB / 5V FLASH 50 mA 100 mA - - 

MC 952 / 4 MB / 5V FLASH 40 mA 90 mA - - 

MC 952 / 8 MB / 5V FLASH 50 mA 100 mA - - 

MC 952 / 16 MB / 5V FLASH 55 mA 110 mA - - 

MC 952 / 32 MB / 5V FLASH 55 mA 110 mA - - 

MC 952 / 64 MB / 5V FLASH 55 mA 110 mA - - 
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9.4 Frequently Asked Questions 

9.4.1 Questions Regarding the Memory Card 

When should I use a FLASH card and when a RAM card? 
Answer: 

FLASH card: 

• Typical application: when program changes are no longer necessary. The 
program resides on the memory card. 

• The CPU > Options > Autoload function is not possible! 

RAM card: 

• Die CPU > Options > Autoload function is possible! 

• Typical application: during commissioning, i.e., as long as program changes 
are still necessary. 

Additional Information 

Memory cards are described in Memory Cards, the CPU > Options > Autoload 
function is described in Connecting the CPU 41x-2 PCI to the Power Supply 

Is a memory card required for operation? 
Answer: 

No, as long as the load memory capacity of 256 Kbytes integrated in the CPU 41x-
2 PCI is sufficient. 

Additional Information 

The technical specifications for the CPU 41x-2 PCI are provided in Performance 
Features and Technical Specifications of the CPU 412-2 PCI and Performance 
Features and Technical Specifications of the CPU 416-2 PCI. 
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9.4.2 Questions Regarding PROFIBUS DP 

Can WinAC Slot 41x also be operated as a DP slave? 
Answer: 

Yes! 

Additional Information 

For additional information on operating the CPU 41x-2 PCI as a DP slave, refer to 
the S7-400 documentation. 

Does the PROFIBUS DP interface that is integrated on the CPU 41x-2 PCI support 
the DP services (SFC58/59)? 

Answer: 

Yes! 

9.4.3  Questions Regarding Communication 

Does WinAC Slot 41x Support Network Routing? 
Answer: 

The "Routing" feature allows you to have online access to S7 stations across 
subnet boundaries using the programming device or PC. This means that you can 
access a DP slave from Industrial Ethernet using WinAC Slot 41x. Typical 
applications include: 

• Loading application programs 

• Loading hardware configuration 

• Performing testing and commissioning functions 

Special "routing tables" for the gateways are generated automatically for this 
purpose during network configuration. These routing tables represent special 
system data, and they also have to be loaded to the individual gateways, i.e., to the 
WinAC Slot 41x. Afterwards, the path to the selected automation device via the 
gateways can be found when you go online with the programming device.  

Additional Information 

For additional information on how routing works, refer to the STEP 7 online help: 
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Is additional software required when using the integrated Industrial Ethernet 
interface of SIMATIC PCs? 

Answer: 

The drivers are located on the SIMATIC NET CD, named according to the required 
function:  

• Softnet S7 for Industrial Ethernet (64 S7 connections, PG/OP, OPC, S7 
communication) 

• Softnet S7 for Industrial Ethernet (8 S7 connections, PG/OP, OPC, S7 
communication) 

• Softnet PG for Industrial Ethernet (PG/OP only) 

How can PC applications access process data of WinAC Slot 41x? 
Answer: 

There are several options available: 

• Prodave MPI 

• Technological application created with WinAC ODK 

• SIMATIC NET OPC Server 

Communication with WinCC or WinCC flexible takes place over integrated 
interfaces. 
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9.5 Compatibilities 

Compatibility with STEP 7 
 

WinAC Slot 412/416 
PC Software CD 

Firmware Version of 
WinAC Slot Module 

Configuration in 
STEP 7 as 

Required STEP 7 
Version 

V3.4 V3.4 CPU 41x-2 PCI V3.4 STEP 7 V5.3 or 
higher 

V4.0 V3.4 CPU 41x-2 PCI V3.4 STEP 7 V5.3 or 
higher 

V4.0 V4.0 CPU 41x-2 PCI V4.0 STEP 7 V5.3 SP2 or 
higher, plus installed 
hardware update for 
the CPU 41x-2 PCI, if 
necessary 

Compatibility with SIMATIC NET 
 

WinAC Slot 412/416  
PC Software CD  

Windows Version Version of SIMATIC NET CD 

Windows 2000 SP3 11/2003 or later V3.4 

Windows XP SP1 11/2003 or later 

Windows 2000 SP3 Software Edition 2005 HF 1 or higher V4.0 

Windows XP SP1 Software Edition 2005 HF 1 or higher 
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Use of Shared Memory Interface (Dual Port RAM) 
 

WinAC Slot 412/416  
PC Software CD  

WinAC Slot SMX WinAC ODK 

V3.4 V3.3 V4.1 

V4.0 V3.3 V4.1 

Configurations of WinAC Slot 412/416 V3.2 to V3.4 can be transferred to WinAC 
Slot 412/416 V4.0 without restrictions. 

To utilize the new functions of the WinAC Slot 412/416 V4.0, the new firmware 
version CPU 41x-2 PCI, V4.0 must be transferred from the HW catalog. 

Product Version Compatibility and Supported Operating Systems  
The table shows the viable combinations of WinAC Slot PC software versions and 
firmware versions and Microsoft operating systems. 

 

Firmware 
Version of 
WinAC Slot 

Module 

WinAC Slot 
412/416 PC 

Software CD 

Microsoft 
Windows NT4 
Workstation 

SP6 

Microsoft 
Windows 2000 
Professional 

SP3 

Microsoft 
Windows XP 
Professional 

SP1 

V3.4 V3.3 No Yes Yes 

V3.4 V3.4 No Yes Yes 

V3.4 V4.0 No Yes Yes 

V4.0 V4.0 No Yes Yes 

 

The WinAC Slot 412/416 V3.3, V3.4, and V 4.0 product versions are fully backward 
compatible. If you want to use Microsoft Windows NT4 Workstation, you can use 
SIMATIC WinAC Slot 412/416 V3.2, which is still available. 
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9.6 Spare Parts and Accessories - Order Numbers 
  

For additional order numbers, refer to Catalog ST 70. 

  
Spare Parts/Accessories Order Number 

CPU 412-2 PCI 6ES7 612-2QH10-0AB4 

CPU 416-2 PCI 6ES7 616-2QL10-0AB4 

Lithium battery 3.6 V 6ES7 971-2BA00-0AA0 

Bus connector without a programming 
device socket 

6GK1 500-0EA02 

Bus connector with a programming 
device socket  

6ES7 972-0BB40-0XA0 
(Note that if you are using this bus connector 
you cannot plug in an external 24 VDC supply. 
Also, in certain PC models the bus connector 
may not be able to be plugged in. 

Connector for external 24 VDC supply Manufacturer: Phoenix Contact 
Item No. 1792524 
Type MVSTBW 2,5/2-ST 
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9.7 Guideline for Handling Electrostatic Sensitive Devices 
(ESD) 

Introduction 
In this appendix, we explain 

• What is meant by "electrostatic sensitive devices" 

• The precautions you must observe when handling and working with 
electrostatic sensitive devices 

What are ESDs? 
Definition 

All electronic modules are equipped with large-scale integrated ICs or components. 
Due to their design, these electronic elements are very sensitive to overvoltages 
and thus to any electrostatic discharge. 

Electrostatic sensitive devices are frequently referred to by the abbreviation ESD. 
This is also the international abbreviation for such devices. 

Electrostatic sensitive devices are identified by the following symbol: 

 
 

Caution 
Electrostatic sensitive devices can be irrevocably damaged by voltages that are 
far below the voltage values that can by perceived by human beings. These 
voltages are present if you touch a component or the electrical terminals of a 
device without first discharging static electricity. In most cases, the damage to a 
device caused by an overvoltage is not immediately noticeable but rather is first 
apparent only after a prolonged period of operation. 
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Electrostatic Charging of Persons 
Charging 

Every person with a non-conductive connection to the electrical potential of his/her 
surroundings can be electrostatically charged. 

The figure shows the maximum values for electrostatic voltages to which a person 
can be exposed when coming into contact with the materials indicated in the figure. 
These values correspond to the specifications of IEC 801-2. 

 

General Protective Measures Against Electrostatic Discharge 
Ensure sufficient grounding 

Make sure that personnel, working surfaces, and packaging are sufficiently 
grounded when working with electrostatic sensitive devices. In this way, you avoid 
static charging. 

For example, touch the PC housing before performing work in the PC. 

 

Avoid direct contact 

You should never touch electrostatic sensitive devices unless it is unavoidable 
(e.g., during maintenance work). Hold devices without touching the pins of the 
components or the printed conductors. In this way, the energy of electrostatic 
discharges cannot reach and damage the sensitive devices. 

If you have to carry out measurements on a device, you must discharge your body 
before you start the measurement by touching grounded metal objects. Use only 
grounded measuring devices. 

 



Reference Information 

Windows Automation Center, WinAC Slot Version 4.0 
Hardware Installation and Operating Manual, Edition 02/2006, A5E00273194-02 171 

9.8 List of Abbreviations 
 

Abbreviations Description 

CP Communications processor 

CPU Central processing unit 

DB Data block 

FB Function block 

FC Function 

FM Function module 

GD Global data communication 

IM Interface module 

LAD Ladder logic 

LWL Fiber-optic cable 

M Ground connection 

MPI Multipoint interface 

OB Organization block 

OP Operator panel 

POI Process output image 

PII Process input image 

PG Programming device 

PLC Programmable logic controller 

PS Power supply 

PZF I/O area access error 

SFB System function block 

SFC System function 

SM Signal module 

STL Statement List (STEP 7 notation) 
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Glossary 

Backplane bus:  
For hardware controllers such as the S7-300 or S7-400, the backplane bus is the 
printedcircuit board on the inside panel of the rack into which modules are inserted. 

Backup battery:  
The backup battery ensures that the -> user program in the -> CPU is stored inthe 
event of a power failure and that defined data areas and memory markers,timers 
and counters are retentive. 

Bit memory:  
Bit memory is part of the -> system memory of the CPU for storing interim results. 
Bit-, byte-, word-, or double word-access of bit memory is possible. 

Bus:  
A bus is a communication medium connecting several nodes. Data 
transmissioncan be serial or parallel across electrical conductors or fiber-optic 
cables. 

Chassis ground:  
The chassis ground is the sum of all the interconnected inactive parts of aresource 
which cannot assume a hazardous contact voltage even in the event of afault. 

Cold restart:  
The controller executes OB 102 before starting the free cycle (OB 1). Like a warm 
restart, acold restart resets the peripheral inputs (PI) and changes the peripheral 
outputs (PQ) to a predefinedsafe state (default is 0). However, a cold restart does 
not save the retentive memory (M, T,C, or DB), but sets these areas to their default 
(initial) values. 

Communication interface:  
CP cards, Siemens PC built-in PROFIBUS interface, or Industrial Ethernetinterface 
that WinLC RTX uses for communications. 

Configuration:  
Assignment of modules to racks/slots and (for example, for signal 
modules)addresses. 
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Configuring:  
By configuring we mean the grouping of individual modules to form an 
automationsystem. 

Counter:  
Counters are component parts of the -> CPU system memory. The contents of 
the"counter cells" can be modified by STEP 7 instructions (for example, 
countup/count down). 

CP:  
Communications processor: Communications processors are modules for point-to-
point links and bus links. 

CPU:  
A central processing unit is the main processing unit of the automation system 
witha processor, arithmetic unit, memory, operating system and interface for 
theprogramming device. 

Data block:  
Data blocks (DB) are parts of the user program that contain the program data. 
There are global data blocks, which can be accessed by all logic blocks, and 
thereare instance data blocks, which are assigned to a specific FB call. 

Default setting:  
The default setting is a useful basic setting which is always used when no 
othervalue is specified (assigned). 

Electromagnetic compatibility:  
By electromagnetic compatibility we mean the ability of an electrically 
operatedresource to operate in a specified environment without influencing that 
environmentin an unauthorized manner. 

Equipotential bonding:  
Electrical connection (equipotential bonding conductor) which gives the bodies 
ofelectrical equipment and external conducting bodies the same or approximately 
thesame potential, in order to prevent interference or dangerous voltages from 
beinggenerated between these bodies. 

Error handling using OB:  
If the operating system detects a specific error (for example,an access error 
withSTEP 7), it calls the organization block (error OB) which is provided for this 
eventand which specifies the subsequent behavior of the CPU. 
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Error indication:  
The error indication is one of the possible responses of the operating system to a-> 
runtime error. The other possible reactions are: -> error reaction in the 
userprogram, STOP mode of the CPU. 

Error reaction:  
Reaction to a -> runtime error. The operating system can respond in the 
followingways: conversion of the programmable controller to the STOP mode, call 
of anorganization block in which the user can program a response or display of 
theerror. 

Flash EPROM:  
FEPROMs are the same as electrically erasable EEPROMS in that they can 
retaindata in the event of a power failure, but they can be erased much more 
quickly(FEPROM = Flash Erasable Programmable Read Only Memory). They are 
used on -> memory cards. 

Free cycle:  
The free cycle consists of the basic tasks for priority class 1: writing to the outputs, 
reading theinputs, executing OB 1, and completing the sleep time requirement 
before triggering the next freecycle. The controller executes these tasks at the 
base, or lowest, internal priority level for executingthe OBs. (Priority level in this 
context refers to OB priority classes, not the operating system prioritylevel.) 

Function block:  
A function block (FB) in accordance with IEC 1131-3 is a -> logic block with ->static 
data. An FB allows parameters to be passed in the user program. Functionblocks 
are therefore suitable for programming complex functions, e.g. closed-loopcontrols, 
mode selections, which are repeated frequently. 

Global data:  
Global data are data that can be addressed from every logic block (FC, FB, OB). 
Specifically, these are bit memory (M), inputs (I), outputs (Q), timers (T), counters 
(C) and data blocks (DB). Both absolute access and symbolic access of global 
data are possible. 

Global data communication:  
Shared data communication is a procedure used to transfer shared data 
betweenCPUs (without CFBs). 
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Ground:  
The conducting earth whose electric potential can be set equal to zero at any point. 
In the vicinity of grounding electrodes, the earth can have a potential different 
tozero. The term “reference ground” is frequently used to describe 
thesecircumstances. 

Ground, to:  
To ground means to connect an electrically conducting component to the 
groundingelectrode (one or more conducting components which have a very good 
contactwith the earth) across a grounding system. 

Hardware:  
Hardware is the name given to the complete physical and technical equipment ofan 
automation system. 

Hot restart:  
All data areas (timers, counters, bit memory, data blocks) and their contents are 
retained. The controller executes OB 101, reads in the process input image, and 
then continues processing the user program at the location where it was last 
stopped. 

Index:  
A numbered slot in the PC Station, or virtual rack that represents a PC-based 
automation system. The controller occupies one index. Other components can 
occupy other index slots. 

Industrial Ethernet:  
Physical communications layer that supports communication to STEP 7, S7 
CPUs,PGs, OPs, and S7 applications. 

Interface, multipoint: -> MPI 

Interrupt:  
Interrupt is the name given to the interruption of program scanning in the 
processorby an externally queued event – for example, timer expired, data request, 
etc. 

Isolated:  
On isolated input/output modules, the reference potentials of the control and load 
circuits are galvanically isolated, e.g., by optical coupler, relay contact, or 
transformer. Input/output circuits can be connected to common potential. 
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Load memory:  
Memory area (RAM) allocated for all of the blocks downloaded from STEP 7 
excluding thesymbol table and comments. It is implemented either as a plug-in 
memory card or apermanently integrated memory. 

Local data:  
Local data are temporary data of a block that are stored while the block is being 
processed in the L stack but are no longer available after block processing is 
complete. 

Logic block:  
A logic block in SIMATIC S7 is a block which contains a section of the STEP 7user 
program (as opposed to a -> data block, which only contains data). 

Memory card:  
Memory cards are memory media in smart card format for CPUs and CPs. They 
are implemented as -> RAM or -> Flash EPROM. 

Mode:  
The SIMATIC S7 automation systems have the following operating states: STOP, 
RESTART, RUN. 

Mode switch:  
The mode switch is used to set the mode you require on the CPU. 

Module parameters:  
Module parameters are values that can be used to control the behavior of 
themodule. A distinction is made between static and dynamic module parameters. 

MPI:  
The multipoint interface (MPI) is the programming device interface of SIMATIC S7. 
It enables the simultaneous operation of several stations (programming 
devices,text displays, operator panels) on one or more CPUs. Each station is 
identified bya unique address (MPI address). 

Nesting depth:  
One block can be called from another by means of a block call. Nesting depth isthe 
number of -> logic blocks called at the same time. 



Glossary 

 Windows Automation Center, WinAC Slot Version 4.0 
178 Hardware Installation and Operating Manual, Edition 02/2006, A5E00273194-02 

Network:  
In terms of communications, a network is the interconnection of several CPUs 
andother terminal – for example, a programming device – by means of 
connectingcables. Data exchange is performed between the connected devices. 

Node address:  
The node number represents the "number" of a CPU, the programming device, or 
another intelligent I/O module if they communicate with one another over a 
network. The node address is assigned with the STEP 7 software. 

Non-isolated:  
On non-isolated input/output modules, there is an electrical connection betweenthe 
reference potentials of the control and load circuits. 

OP:  
Operator panel 

Operating system of the CPU:  
The operating system of the CPU organizes all functions and processes of theCPU 
that are not associated with a specific control task. 

Organization block (OB):  
Organization blocks (OBs) form the interface between the operating system and 
the user program. They are called from the operating system and control cyclic and 
interrupt-triggered program execution, the restart behavior of the controller,and 
error handling. 

PC station:  
Representation of a software-based virtual rack that defines a PC-based 
automation system. 

PCI Bus:  
Abbreviation for “peripheral component interconnect bus”. The PCI bus is 
thestandard bus on the AT-compatible PC. 

PG/OP communication:  
Communication between the controller and other S7 applications such 
asprogramming devices, operator panels, and S7 controllers. WinAC Slot supports 
PROFIBUS, MPI, and Industrial Ethernet for PG/OP communication. 



Glossary 

Windows Automation Center, WinAC Slot Version 4.0 
Hardware Installation and Operating Manual, Edition 02/2006, A5E00273194-02 179 

PLC:  
-> Programmable logic controller 

Process image:  
The process image is an integral part of the system memory of the S7-400CPU. 
The signal states of the input modules are written into the process-imageinput table 
at the start of the cyclic program. At the end of the cyclic program, thesignal states 
in the process-image output table are transferred to the outputmodules. 

PROFIBUS:  
Physical communications layer that can be used for PROFIBUS DP 
communications to I/O orS7 communications to STEP 7, S7 CPUs, and S7 
applications. 

PROFIBUS DP:  
Using PROFIBUS-DP, you can set up a distributed I/O system. Digital and 
analogmodules are transferred by the automation system to the process on site – 
andover a distance of up to 23 km at that (when using fiber–optic cables). The 
digital and analog modules are connected to the automation system via 
thePROFIBUS-DP fieldbus and addressed in the same way as centralized I/O. 
PROFIBUS-DP conforms to the standard EN 50 170 Volume 2, PROFIBUS. 

Programmable logic controller:  
Programmable logic controllers (PLCs) are electronic controllers whose function 
issaved as a program in the control unit. The configuration and wiring of the 
devicetherefore do not depend on the function of the controller. The programmable 
logiccontroller has the architecture of a computer; it consists of -> CPU with 
memory,I/O modules and internal bus system. The I/O and the programming 
language aredesigned to meet the control engineering requirements. 

Programming device:  
Programming devices are essentially personal computers which are 
compact,portable and suitable for industrial applications. They are equipped with 
specialhardware and software for SIMATIC programmable controllers. 

RAM:  
A RAM (random access memory) is a semiconductor with random access. 

RESTART:  
RESTART mode is activated on a transition from STOP mode to RUN mode. It can 
be initiated by the mode selector switch, after a Power On, or through an operator 
input on the programming device. 
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Restart method:  
The restart method determines which startup OB is executed whenever the 
controllerchanges from STOP mode to RUN mode. The startup OB allows you to 
initialize your STEP 7 userprogram and variables. The restart methods are: Cold 
restart (OB 102), hot restart (OB 101) and warm restart (OB 100). 

Retentive data:  
Retentive data are not lost in the event of a line voltage failure if there is a 
backupbattery. 

Runtime error:  
Errors that occur during running of the user program in the automation system 
(inother words, not in the process). 

S7 communication:  
Communication between controllers on the network, hardware or software, using 
theS7 communication functions. 

S7 routing:  
Communications between S7 controllers, S7 applications or PC Stations across 
differentsubnets through one or more network nodes acting as routers, configured 
with NetPro. 

Scan cycle:  
The scan cycle includes writing to the outputs, reading the inputs, executing OB 1 
and all otherOBs, and completing the sleep time requirement. 

Scan cycle time:  
Time required to execute the complete scan cycle, which includes the execution of 
OB 1and the minimum sleep time. 

Station Configuration Editor:  
Tool, accessible from taskbar, for configuring the PC Station. 

STEP 7:  
Programming language for programming, configuring and assigning parameters 
touser programs for SIMATIC S7 PLCs. 
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STEP 7 user program:  
Application program created with STEP 7 and downloaded to the controller 
forexecution. It includes all organization blocks (such as OB 1 or OB 35) and the 
other logic blocksthat they call, including functions (FCs), system functions (SFCs), 
function blocks (FBs), andsystem function blocks (SFBs). 

System function (SFC):  
Preprogrammed function that is integrated as a part of the operating system ofthe 
controller and can be accessed in the STEP 7 user program, when necessary. 

System function block (SFB):  
Function block that is integrated as a part of the operating system of thecontroller 
and is not downloaded as part of the STEP 7 user program. Like a function block 
(FB),an SFB is a block "with memory." You must also create an instance data block 
(DB) for the SFB. The instance DB is then downloaded to controller as part of the 
STEP 7 user program. 

System memory:  
The system memory is integrated on the CPU and implemented as RAM. 
Thesystem memory includes the operand areas (for example, timers, 
counters,memory markers, etc.) as well as the data areas (for example, 
communicationbuffers) required internally by the -> operating system. 

Time synchronization:  
The ability to broadcast a system standard time from a single source to all 
deviceswithin the system so that they may set their own clocks to the standard 
time. 

Time synchronization service:  
Software component of WinAC RTX that provides the capability tosynchronize time 
between components in the PC Station. (See the documentation for the 
WinACTime Synchronization Service.) 

Timers:  
-> Timers 

Transmission rate:  
Rate of data transfer (bps). 

Ungrounded:  
Without galvanic connection to ground 
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Version:  
Products having the same order number are distinguished by their version. 
Theproduct version is incremented with each upwardly compatible function 
extension,production-related modification (use of new components) or bug fix. 

Virtual backplane bus:  
For PC-based controllers, the virtual backplane bus is a software-based, 
virtual"rack" that enables communications between the controller and other PC 
Station components. 

Warm restart:  
Type of restart where the controller executes OB 100 before starting the free cycle 
(OB 1). A warm restart resets the peripheral inputs (PI) and places the peripheral 
outputs (PQ) into a predefinedsafe state (default is 0). The warm restart also saves 
the current value for the retentivememory areas for the bit memory (M), timers (T), 
counters (C), and data blocks (DBs). 

Warm restart:  
When the CPU restarts (for example, after changing the mode selector switch: from 
STOP to RUN or after a Power ON), organization block OB 100 (Warm Restart) is 
executed before cyclic program processing (OB 1). With a warm restart, 
theprocess input image is read in and the STEP 7 user program is 
executedstarting with the first command in OB 1. 

Work memory:  
Memory area (RAM) allocated for the blocks used at runtime. 
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